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About This Manual

This manual provides an overview of Sound Power Plus. It includes 
information about configuring your software and using it to take acoustic 
measurements. Sound Power Plus is designed for use with 
Windows 2000/NT/Me/9x. 

Conventions
The following conventions appear in this manual:

» The » symbol leads you through nested menu items and dialog box options 
to a final action. The sequence File»Page Setup»Options directs you to 
pull down the File menu, select the Page Setup item, and select Options 
from the last dialog box.

This icon denotes a tip, which alerts you to advisory information.

This icon denotes a note, which alerts you to important information.

bold Bold text denotes items that you must select or click on in the software, 
such as menu items and dialog box options.

italic Italic text denotes variables, emphasis, a cross reference, or an introduction 
to a key concept.

monospace Text in this font denotes text or characters that you should enter from the 
keyboard. This font is also used for the proper names of disk drives, paths, 
directories, programs, subprograms, subroutines, operations, variables, 
filenames, and extensions.

Related Documentation
The following documents contain information that you might find helpful 
as you read this manual:

• ANSI S1.13., Measurement of Sound Pressure Levels in Air. ANSI 
standards are available through the American National Standards 
Institute website at www.ansi.org

• ECMA-74. ECMA standards are available through the ECMA website 
at www.ecma.ch
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• ISO 3744, 3745, and 7779. ISO standards are available through the 
International Organization for Standardization website at 
www.iso.ch

• Nobile, Matthew A. and Gordon R. Bienvenue. A Procedure for 
Determining the Prominence Ratio of Discrete Tones in Noise 
Emissions. Institute of Noise Control Engineering (INCE) 
Noise-Con 91 proceedings. This document is available from INCE 
at www.ince.org
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1
Introduction to 
Sound Power Plus

National Instruments Sound Power Plus automates the acquisition and 
analysis of computer and business equipment noise emission measurement 
data. With Sound Power Plus, you can acquire data from multiple sources 
simultaneously using as many as five National Instruments Dynamic 
Signal Analysis (DSA) devices, dramatically increasing the speed and 
efficiency of your application.

Sound Power Plus implements the acoustic measurement procedures 
defined in ISO 7779 and ECMA-74. In addition, Sound Power Plus 
supports a number of user-configurable options that allow you to 
implement several other basic sound power and sound pressure level 
measurement standards, such as ISO 3744, ISO 3745, ISO 6926, 
ANSI S12.34, and ANSI S12.35. You can easily adapt the software to 
implement a number of equipment test codes that require measurement 
of sound power and sound pressure levels of various devices.

System Requirements
Your system must meet the following requirements to run Sound 
Power Plus:

• 133 MHz Pentium or higher microprocessor 

• Microsoft Windows 2000/NT/Me/9x

• 64 MB RAM

• 50 MB available hard drive space.

• National Instruments NI 455x DSA device

• LabVIEW 6.0 or higher

• National Instruments Real-Time Octave Analysis Software, 
version 1.2 or higher

• NI-DAQ 6.9.1 or higher
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• A National Instruments GPIB device, if you plan to use a 
GPIB-based multiplexer

• Microsoft Excel 97 or 2000 (required to export data, import 
microphone sensitivity and frequency response data, and execute 
source code)

If you have purchased the Sound Power Plus Developer Software package, 
you must have the following software components to take advantage of the 
editable source code feature:

• LabVIEW Full Development System for Windows or LabVIEW 
Professional Development System for Windows

• National Instruments LabVIEW Sound and Vibration Toolset for 
Windows, version 1.0 or higher

Program Overview
Sound Power Plus is a LabVIEW application. 

Note Owners of a source code license and the appropriate LabVIEW applications can 
access the source code to modify the software to fit their particular laboratory or test needs.

Test Routines
Sound Power Plus implements the following basic test routines:

• Sound power level measurement in a free field or free field over 
reflecting plane test environments

• Sound pressure level measurements, including sound quality analysis 
using prominent tone and impulsive noise analysis

Measurement Devices
The software uses at least one or as many as five National Instruments 
NI 4551 or NI 4552 DSA boards as measurement devices.

Drivers
Sound Power Plus includes drivers for several external devices commonly 
used to support automated measurement of computer noise emissions, such 
as microphone multiplexers. These drivers permit rapid configuration to 
accommodate a wide variety of laboratories. Appendix C, Supported 
Drivers, lists the drivers supported by Sound Power Plus.
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Data Files
The software can export data to three types of files: binary files, Microsoft 
Excel files, and text files. The Save Measurement function generates a 
binary data file for each test serial number. This file contains test 
documentation, measurement configuration information, sound power 
data, and sound pressure level data. The Export to Excel function exports 
all test information into an Excel template file. The Export to Text File 
function exports all or selected test information into a text file so that you 
can apply your own data analysis techniques to the measured data.

The program also creates several other files that contain instrument 
configuration, measurement configuration, and calibration data. These 
files can be saved and loaded into the program, which lets you quickly 
reconfigure standard configurations. For more information, refer to 
Appendix B, Program and Data Files.
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User Interface and General Program Layout
Figure 1-1 illustrates the Sound Power Plus user interface, which consists 
of a three-window screen layout.

Figure 1-1.  Sound Power Plus User Interface

1 Flowchart Window 2 Main Menu Bar 3 Graphic Window 4 Data Window

1

2

3

4
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Flowchart Window
The flowchart window at the left side of the screen guides you through the 
configuration, test documentation, calibration, and measurement routines. 
By clicking a button, you sequentially execute each step necessary to 
complete a routine. Clicking a flowchart button either opens a data window 
or activates another flowchart.

Flowchart buttons are color-coded to describe the current status of each 
step. The following table lists each button color and its corresponding 
status.

The status of each button is updated either when you complete a step 
(by clicking OK in a data window) or when you load data that satisfies 
the step. 

Click the Return to Main Menu button to exit the current flowchart 
routine and return to the main menu.

Data Window
The data window at the bottom of the screen contains controls for setting 
up configurations and taking measurements. The controls let you select 
positions to be measured, start measurements, and accept the data. 
Measurement results are displayed in data tables located in this window.

Table 1-1.  Flowchart Button Display States

Display State Status

Control is available. All previous required steps are 
complete.

Control is unavailable. Previous required steps are not 
complete, or current action does not allow use of this 
control.

All required actions for this step are complete.

Blue Box

Grayed Out
Blue Box

Green Box
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When the main menu flowchart is active, the data window shows the data 
and configuration files currently in use by the program. The following files 
are displayed:

• Measurement—The current measurement data file, if the current 
measurement has been saved. If the current measurement data has not 
been saved, this field is blank.

• Calibration—The current calibration data file, if the current calibration 
data has been saved. If the current calibration data has not been saved, 
this field is blank.

• Instrument Configuration—The current instrument configuration file. 
Initially, Sound Power Plus displays the default instrument 
configuration file. This file name will change when the instrument 
configuration settings are saved to a named file or when a named file 
is loaded.

• PWL Configuration—The current sound power level measurement 
configuration file. Initially, Sound Power Plus displays the default 
sound power level configuration file. This file name will change when 
the sound power level configuration settings are saved to a named file 
or when a named file is loaded.

• SPL Configuration—The current sound pressure level measurement 
configuration file. Initially, Sound Power Plus displays the default 
sound pressure level configuration file. This file name will change 
when the sound pressure level configuration settings are saved to a 
named file or when a named file is loaded.

Graphic Window
The graphic window at the top of the screen automatically updates based 
on the routine you are executing:

• During ambient and source sound pressure level measurement 
routines, this window becomes a 1/1-octave band or 1/3-octave band 
Real Time Analyzer (RTA) display and contains controls associated 
with the RTA.

• During the Fast Fourier Transform (FFT) source sound pressure level 
FFT measurement in the sound power level routine, or during 
prominent tone analysis in the operator/bystander sound pressure level 
routine, this window becomes an FFT analysis display and contains 
controls associated with the FFT analyzer.

• During measurement review routines, this window becomes a test 
results display and contains information about the results and controls 
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associated with the test results display and the reference spectrum 
features.

The following sections describe the graphic window display modes in more 
detail.

RTA Display
The RTA display consists of a series of indicators for each 1/1-octave band 
or 1/3-octave band. When not performing a particular measurement, these 
indicators display the instantaneous “slow” sound pressure level (SPL). 
Figure 1-2 illustrates the parts of an RTA display.

Figure 1-2.  Sample RTA Display Window

The RTA display can display 1/1-octave spectrums. Each band level is the 
sum of three 1/3-octave bands within the 1/1-octave band. Use the switch 
to alternate between 1/1- and 1/3-octave bands. The RTA display includes 
two overall level indicators. The left overall level indicator displays the 
instantaneous slow linear SPL. The right overall indicator displays the 

1 RTA Cursor
2 Overall Linear SPL
3 Overall Awtd SPL
4 Cursor Controls
5 1/1 and 1/3 Octave Switch
6 Display Switch

7 Position Ring
8 Save Reference Spectrum
9 Input Range Control
10 Offset of Awtd From Impulsive
11 Current Awtd Impulsive SPL
12 Current SPL at Center Frequencies

13 Current Awtd SPL
14 Nominal Sensitivity
15 Current Linear SPL
16 Input Source
17 Frequency Axis
18 Sound Level Axis

18

17

16

15 14 13 12 11 10

6

7

8

9

54321
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instantaneous slow A-weighted (Awtd) SPL. The Awtd display contains an 
additional orange indicator that displays the impulse, A-weighted SPL.

The RTA display can display a frequency range of 25 to 20,000 Hz, 
depending on the frequency range you configure in the sound power 
or sound pressure level measurement configuration.

Alphanumeric Indicators
A series of alphanumeric indicators display the following information:

• The input source (position, data acquisition board and channel 
number) for the current measurement, followed by the microphone 
sensitivity (in mV/Pa)

• The current SPL in the frequency band selected by the cursor, followed 
by the center frequency of the selected 1/1- or 1/3-octave band

• The current linear SPL

• The current Awtd SPL

• The current Awtd impulsive SPL

• The amount by which the current Awtd impulsive sound pressure level 
exceeds the current Awtd sound pressure level

RTA Cursor
A movable cursor lets you select any band for the alphanumeric display 
band level. Use the yellow arrow controls at the upper-right corner of the 
RTA display to move the cursor to the desired band and read the selected 
measurement in the alphanumeric display.

RTA Controls
The RTA display is automatically configured based on the frequency 
range you set in the sound power or sound pressure level measurement 
configuration. To change the upper and lower limits of the level axis, 
double-click the upper or lower limit levels and edit the value displayed. 
The axis automatically rescales.

The RTA display includes the following controls:

• 1/1 and 1/3 Octave—Use this switch to toggle the spectrum display 
between 1/1-octave and 1/3-octave bands.

Note The octave band feature only allows the display of the current RTA data in 
1/1-octave bands. Data stored in Sound Power Plus native file format or exported by Sound 
Power Plus is in 1/3-octave bands.
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• Display—Select one or more measured positions in the data window 
to enable the display switch. The RTA display toggles between the 
measured octave spectrum and free running octave spectrum. If you 
select more than one measured spectrum and the display switch is set 
to Measured, RTA displays only the first selected position.

Note If the display control is set to RTA, the RTA displays the spectrum of the current 
position selected in the Position control.

• Position—Use the drop-down list box to select the position you want 
to monitor in RTA. The options available in this list box are determined 
by the type of measurement you select.

• Range—This dial sets the input range of the instrument. 
If auto-ranging is enabled, as shown in the Auto-Ranging 
Configuration section in Chapter 2, Installation and Configuration, 
this dial is not available. 

• Save Spectrum—Click this button to save the current sound pressure 
level spectrum into a reference spectrum file. A dialog box prompts 
you to enter a file name for the reference spectrum.
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FFT Display
The FFT display can graphically display the results of the FFT at one 
or more selected positions and the average FFT, if selected. Figure 1-3 
illustrates the parts of an FFT display.

Figure 1-3.  Sample FFT Display Window

Sound Power Plus acquires and displays an 800-line FFT during the sound 
power source FFT sound pressure level routine and a 12,800-line FFT 
during the prominent tone analysis routine. The frequency range is 
determined by the FFT measurement configuration.

Alphanumeric Indicators
A series of alphanumeric indicators display the following information:

• The source of the current FFT spectrum being acquired (position, 
data acquisition channel, and channel number)

• The calibrated input sensitivity of the input device

• The frequency and level at the primary (yellow) cursor location

1 Cursor Controls
2 Position Ring
3 Save Reference Spectrum
4 Input Range Controlsl
5 Primary Cursor Location/Levell

6 Secondary Cursor 
Location/Level

7 Difference Between Primary and 
Secondary Cursors

8 Input Source/Nominal Sensitivity

9 Frequency Axis
10 Level Axis
11 Secondary FFT Cursor
12 Primary FFT Cursor

11 12 1

2

3

4

567

10

9

8
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• The frequency and level at the secondary (orange) cursor location

• The frequency difference between the two cursors and total energy 
between cursors

Note When multiple spectra are being displayed, the total energy between the cursors 
is only displayed if both cursors are selected on the same spectrum.

FFT Cursors
Two movable cursors allow you to select any two frequencies in the FFT 
spectra. Use the yellow arrow controls at the upper-right corner of the FFT 
display to move the cursor to the desired frequency and read the selected 
level and frequency in the alphanumeric display.

When the two cursors select frequencies on the same spectrum, the 
alphanumeric display provides an indicator for the total energy between the 
cursors. When the two cursors select frequencies on different spectra, only 
the frequency difference between the cursors is displayed.

If you want to change to another FFT spectrum, click the crosshairs on 
the cursor and drag the dot to the spectrum and frequency you want. 
If the crosshairs on the cursor are lost and the digital display shows NaN 
(Not a Number), the current cursor is locked on a spectrum that is not 
available. Click the up and down arrow controls at the upper-right corner 
of the FFT display until a number is displayed for the current cursor.

FFT Controls
The FFT display is automatically configured based on the frequency range 
you configure in the sound power or sound pressure level measurement 
configuration. To change the upper and lower limits of the level axis, 
double-click the upper or lower limit levels and edit the value displayed. 
The axis automatically rescales.

The FFT display includes the following controls:

• Position—Use the drop-down list box to select the positions you want 
to measure and display in the FFT Analyzer. This control has no effect 
when you check Display Selected Control in the Source FFT 
Measurement window.

• Range—This dial sets the input range of the instrument. 
If auto-ranging is enabled, this dial is not available. Learn more 
about auto-ranging in Chapter 2, Installation and Configuration.
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• Save Spectrum—Click this button to save the currently displayed FFT 
spectrum to a reference spectrum. A dialog box prompts you to enter a 
file name.

Test Results Display
During the review routine, the graphic window becomes a test results 
display. Figure 1-4 illustrates the parts of a test results display.

 

Figure 1-4.  Sample Test Results Window (PWL Shown)

Alphanumeric Indicators
A series of alphanumeric indicators display the following information:

• The linear sound power level

• The Awtd sound power level

• The sound power level at the current cursor location and the frequency 
at the current cursor location

1 Overall Linear PWL
2 Overall Awtd PWL
3 Legend
4 Cursor Controls

5 Save For Reference
6 Cursor Location/level
7 Awtd PWL
8 Linear PWL

9 Frequency Axis
10 PWL at Cursor Location
11 Sound Power Level Axis
12 RTA Cursor

6

9

10

11 12 1 2 3

4

5
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Test Results Cursor
A movable cursor lets you select any 1/3-octave band for the sound power 
level and frequency to display in the alphanumeric indicators.

Test Results Display Controls
The test results display is automatically configured based on the frequency 
range you configure in the sound power level measurement configuration. 
To change the upper and lower limits of the level axis, double-click the 
upper or lower limit levels and edit the value displayed. The axis 
automatically rescales.

Save Spectrum—Click this button to save the current sound power level 
result as a reference spectrum. A dialog box prompts you to enter a file 
name. If you want the spectrum to appear each time you display a sound 
power level result, save the spectrum in the file named Ref_Sound Power 
Level_Default.ReP.

Main Menu Bar
The main menu bar, located at the top of the Sound Power Plus interface, 
is always visible and active. Use this menu bar to perform the following 
tasks:

• Save and load measurement data files

• Save and load calibration data files

• Save, load, and edit instrument and measurement configuration files

File Menu
Commands on the File menu control the saving and loading of 
measurement data. From this menu, you can do the following tasks:

• Create a new data file using the New Measurement command

• Load a previous measurement using the Load Measurement 
command

• Save the current measurement using the Save Measurement 
command

• Change the default measurement data file directory using the 
Change Directory command

• Exit the program using the Exit command
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Configuration Menu
Commands on the Configuration menu let you load, save, create, and edit 
instrument and measurement configuration files.

• Use the Load options to load a custom or default configuration file.

• Use the Save options to save a custom or default configuration file.

• Use the Settings options to create and edit configuration files and 
configure auto ranging.

You can also configure auto-range settings from this menu.

Calibration Menu
The Calibration menu provides tools for loading and saving calibration 
data and for changing system calibration settings.

Reference Menu
The Reference menu provides tools for loading and editing the system 
reference spectrum.

Option Menu
The Option menu provides a tool for maintaining the system password.

Help Menu
The Help menu lets you access information about Sound Power Plus and 
open the Sound Power Plus online help using the following controls:

• Show Help—Displays the Sound Power Plus online help

• About—Displays information about the version of Sound Power Plus
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2
Installation and Configuration

This chapter describes how to install Sound Power Plus and configure your 
instruments and measurements.

Installation
Follow these instructions to install your Sound Power Plus software.

Configure Windows Settings
Make sure the settings on your computer match these settings before you 
install Sound Power Plus:

• Set your screen resolution to at least 1024 × 768 using at least 
256 colors.

• Set your system to display small fonts.

• Make sure that the Always on top option in the Windows taskbar 
properties is not selected.

Install the Hardware
You must have at least one NI 4551 or NI 4552 DSA device installed on 
your computer to use Sound Power Plus. Also, make sure that you have 
National Instruments NI-DAQ 6.9.1 or higher installed on your system. 

To ensure that the device and instrument driver are properly installed, 
follow these instructions to install each of your NI 4551 or NI 4552 devices:

1. Power off your system and unplug the power cord from your PC.

2. Install each DSA device in a full-length PCI slot.

Tip For detailed installation instructions, refer to the documentation included in your 
National Instruments hardware kit.

3. Replace the power cord and boot the system. The computer 
automatically detects new hardware.
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4. Verify your installation:

a. Open Measurement & Automation Explorer (MAX) from the 
icon on your desktop.

b. Expand Devices and Interfaces in the MAX configuration tree.

c. Verify that all of your DSA devices are listed beneath Devices and 
Interfaces.

Install the GPIB Board
If you plan to use a GPIB-based multiplexer, make sure you have the 
appropriate GPIB board installed in your computer with the appropriate 
drivers. Refer to the documentation that came with your board for detailed 
installation and configuration instructions. Follow these steps to install 
your GPIB board:

1. Power off your system and unplug the power cord from your PC.

2. Install the GPIB board in a free PCI slot.

3. Replace the power cord and boot the system. The computer 
automatically detects new hardware.

4. On the GPIB Configuration screen, select the following options:

a. Set GPIB to 0.

b. Select Board and set Board Type to PCI-GPIB.

5. Click Configure.

6. Verify your installation:

a. Open Measurement & Automation Explorer (MAX) from the 
icon on your desktop.

b. Expand Devices and Interfaces in the MAX configuration tree.

c. Verify that the GPIB device is listed beneath Devices and 
Interfaces.

Install the BNC 2140 Breakout Box
Follow these instructions to install the BNC-2140 breakout box:

1. Locate the SHC68-C68-A1 analog cable that was included in your 
hardware kit.

2. Plug one end of the SHC68-C68-A1 cable into the 68-pin connector on 
the BNC-2140. Insert the other end of the cable into the 68-pin 
connector on your DSA device.

3. Tighten the jackscrews finger-tight on both ends of the cable, and 
reboot your computer. 
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4. You must manually configure the BNC-2140 by setting the channel 
switches: 

a. Set all switches to SE (Single Ended).

b. Turn Integrated Circuit Piezoelectric (ICP®) Off (main and 
individual), unless you are using ICP microphones.

Install the Sound Power Plus Software
1. Close any open programs.

2. Insert the Sound Power Plus CD into your CD drive.

3. An autorun file launches to begin the Sound Power Plus installation. 
If this file does not launch automatically, start the installation manually 
by running setup.exe from the setup folder.

4. Follow the instructions on the screen to complete the installation.

Configuration
The rest of this chapter describes how to configure your instruments and 
measurements. You can provide configuration data to Sound Power Plus 
by loading the configuration information from a file or entering new data 
directly into Sound Power Plus.

Load a Configuration File
Select Configuration»Load to load instrument, sound power 
measurement, and sound pressure measurement configuration files. You 
must create configuration files using the Configuration»Save menu, and 
save those files in Sound Power Plus native format. Sound Power Plus 
does not check the compatibility of the loaded configuration files and the 
hardware in your system. If your configuration file is not compatible 
with your hardware, you will receive an error message when you start a 
measurement. Check file compatibility under Configuration»
Setting»Configuration Functions.

You can also load settings for instrument, PWL measurement, or SPL 
measurement configurations. Select Configuration»Load»Default»All 
if you want to load the default files for all instrument and measurement 
configuration data.

Note Sound Power Plus displays the current instrument, sound power level, and sound 
pressure level configuration files in the data window when the main program menu is active 
in the flowchart window.
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Enter New Configuration Data
Select Configuration»Settings to create or edit instrument, 
PWL measurement, SPL measurement, or auto-ranging configuration 
settings. Selecting this option activates the password entry dialog box. 
You must have the correct password to edit and save new settings. If the 
correct password is not entered, you can only browse, but not change, 
the current settings.

Saving Configuration Data
Select Configuration»Save to save any current instrument, 
PWL measurement, or SPL measurement configuration settings. Select 
Configuration»Save»Default»All if you want to save the current 
instrument and measurement configuration data into each of the three 
system default configuration files. A dialog box prompts you to enter the 
name of the file, and the file is then saved in the Sound Power Plus native 
file format.

Note Default files load each time you launch Sound Power Plus, as well as any time you 
load the system defaults.

Password Protection
All instrument and measurement configuration routines are password 
protected. A dialog box will open and request a password each time you 
access these routines. This dialog will time out if you do not enter data 
within 15 seconds. After 15 seconds, you must restart the configuration 
routine in order to reactivate the password dialog box.

Figure 2-1.  Password Dialog Box

Sound Power Plus ships without an initial password (no characters in the 
password field). To set a new password or change the password, select 
Option»New Password. To disable the password protection feature, use 
a blank field as the password.
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Enter the password you have selected and click OK. After you enter the 
valid password, you can view, edit, and save instrument and measurement 
configuration options.

If you do have the correct password, you will only have read-only access to 
configuration options and settings.

Note If you lose or forget your password, contact National Instruments technical support 
for assistance.

Configuring Your Instruments
The following sections describe how to configure your instruments. The 
first step is to load the configuration information into Sound Power Plus, 
either manually or from an existing file

To load instrument configuration data from a file, select Configuration»
Load»Instrument Configuration. A dialog box prompts you to enter the 
name of the file you want to load. The instrument configuration file must 
be compatible with the number of boards and devices currently installed 
on the system and in Sound Power Plus native file format. Select 
Configuration»Load»Default»Instrument Configuration if you want to 
load the default instrument configuration files.

To manually enter new configuration data or modify existing data, launch 
the instrument configuration routine by selecting 
Configuration»Settings»Instrument, and then selecting a device to 
configure. The Instrument Configuration flowchart window opens, from 
which you can configure other devices. You can edit the following settings:

• Board—Controls and indicators related to the number of DAQ 
boards and configured measurement channels for the system

Note Sound Power Plus automatically detects all boards installed on your computer when 
you execute the Configuration»Settings»Instrument»Board routine. Each detected 
board is automatically enabled and all available input channels are activated.
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• Multiplexer—Controls and indicators that let you select and configure 
multiplexers on each configured instrument channel

• Microphone—Controls and indicators that let you assign microphones 
to each configured input channel using either a DAQ direct input or a 
multiplexer. Access to Excel microphone data files that include 
calibration and frequency response data for system microphones is 
available through this option.

This routine is password protected. If you do not enter the correct 
password, you cannot modify the current instrument configuration settings.

For a more detailed explanation of configuration concepts, refer to 
Appendix A, Configuration Concepts, Protocols, and Calculations.

Data Acquisition (DAQ) Board Configuration
Figure 2-2 illustrates the Data Acquisition Board Configuration window.

 

Figure 2-2.  Data Acquisition Board Configuration Window
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Use this interface to set up your NI 4551 or NI 4552 DSA device. 
You can access this window by selecting Configuration»Settings» 
Instrument»Board from the main menu bar, which activates the 
Instrument Configuration flowchart window. From the flowchart 
window, you can choose other instrument configuration options.

Board—Select this check box to enable the DAQ device. This check box 
must be selected for at least one board or you will be unable to perform any 
measurements or configuration.

Type—Sound Power Plus automatically detects and identifies the type of 
DAQ board installed in your system.

Channels—Select a check box to enable the input channel(s) on the 
DAQ board.

Name—The name assigned by the software that the system uses to refer to 
this DAQ board. 

OK—Click this button to accept the values you entered and exit the 
DAQ board configuration.

Cancel—Click this button to cancel your entries and exit the DAQ board 
configuration.
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Multiplexer Configuration
Figure 2-3 illustrates the Multiplexer Configuration window.

Figure 2-3.  Multiplexer Configuration Window

Use this window to set up your multiplexers. You can access this window 
by selecting Configuration»Settings»Instrument»Multiplexer from the 
main menu bar or by clicking Multiplexer when the Instrument 
Configuration flowchart window is active.

Each DAQ input channel is capable of supporting a multiplexer. Sound 
Power Plus provides several common microphone multiplexers and 
supports plug-in driver architecture for new multiplexers so that you can 
add new National Instruments or custom multiplexer drivers according to 
the plug-in driver structure. Refer to Appendix C, Supported Drivers, for 
more information about supported multiplexer drivers and how to add a 
new plug-in multiplexer driver.
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Note You can configure more than one multiplexer in this window. Enter the information 
for the first multiplexer and then move the scroll bar to toggle through the configuration for 
each additional multiplexer. Do not click OK until you have finished configuring all 
multiplexers.

Multiplexer Setup
Total Multiplexers—Enter the number of multiplexers you want to use.

Note If you are connecting the microphones directly to the BNC 2140 inputs instead of 
using a multiplexer, set Total Multiplexers to equal to the number of microphones and 
select Direct for the Multiplexer Type.

Mux No.—Move the scroll bar to toggle through the configuration for each 
of the multiplexers.

Multiplexer Type—Select your multiplexer from this drop-down list 
box. The configuration information for all multiplexers supported 
by Sound Power Plus is contained in the configuration file, 
\Data\Multiplexer Drivers\Multiplexer.ini. Refer to 
Appendix C, Supported Drivers, for more information on using default 
and plug-in drivers in Sound Power Plus.

Multiplexer Name—Enter a name to identify each multiplexer. This name 
is displayed during measurements. You can change this name by entering 
the new name in the same text box.

GPIB Address/Serial Port—This field varies based on whether your 
multiplexer is GPIB or serial. Enter the GPIB or serial address of the 
multiplexer in this field.

Gain (dB)—Each multiplexer channel may have an associated pre-gain. 
If you are using a pre-gain amplifier on the output of the multiplexer to 
increase the signal-to-noise ratio of the system, enter the gain applied, in 
decibels. This gain is taken into account when calibrating microphones, 
that is, it is included in the microphone sensitivity.

Auto Assign—Click this button to direct Sound Power Plus to 
automatically assign each multiplexer output to the available measurement 
channels in a logical order.

Note Always review the automatic configuration assignments to ensure that the logic 
applied is consistent with your current instrument or measurement configuration 
requirements.
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Multiplexer Assignment
You can assign the output of each configured multiplexer to an input 
channel on your DAQ board.

Multiplexer Output—This indicator lists each multiplexer output you 
configured in Multiplexer Setup. 

DAQ Channels—Use this list box to select an input channel on the DAQ 
board to associate with the multiplexer output.

OK—Click this button to accept the values you entered and exit the 
multiplexer configuration.

Cancel—Click this button to cancel your entries and exit the multiplexer 
configuration.
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Microphone Configuration
Figure 2-4 illustrates the Microphone Configuration window.

Figure 2-4.  Microphone Configuration Window

Use this window to establish a relationship between your microphones and 
measurement channels. You can access this window in the following ways 
selecting Configuration»Settings»Instrument»Microphone from the 
main menu bar or clicking Microphone when the Instrument 
Configuration flowchart window is active.

Based on the number of microphones specified in the Total Number 
control, Sound Power Plus assigns a serially-numbered group of 
microphones, beginning with microphone one (Mic 1). For a description 
of how microphones are assigned, refer to the Measurement Configuration 
section in Appendix A, Configuration Concepts, Protocols, and 
Calculations. 
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You can reassign any microphone to any configured board, input channel, 
and multiplexer channel. However, each microphone must be assigned to 
a unique multiplexer channel or DAQ input channel.

Total Number—Enter the total number of microphones you want to 
configure.

Load Mics—Click this button to import the microphone data from 
an Excel microphone sensitivity file. When you click this button, a 
file dialog box opens from which you can choose the microphone 
sensitivity file you want to load. Select a file and click Open. The Excel file 
stores microphone names, serial numbers, sensitivity offsets, and frequency 
response corrections. See the Microphone Sensitivity Files section in 
Appendix B, Program and Data Files, for more information about viewing 
and editing the microphone sensitivity files.

Available Microphones—This list box contains the configured 
microphones that are available. This information is available once you click 
Load Mics.

Mic #—Move the scroll bar to toggle through the configuration settings for 
each of the microphones by microphone number.

Import—Click this button to assign the microphone you selected from the 
Available Microphones field to the microphone number indicated in the 
Mic # field.

Microphone
You can configure microphones by importing data from the Available 
Microphones list or by entering the values by hand into the Microphone 
Configuration data window. Frequency response corrections can only be 
imported from the data contained in the Excel microphone sensitivity files.

Name—A common name Sound Power Plus uses to refer to the 
microphone (such as Microphone 1, Mic A, and so on). You can select a 
name from the Available Microphones list box, assign a name by editing 
the field, or accept the default name assigned by Sound Power Plus.

Serial Number—Enter a serial number that uniquely identifies the 
microphone by editing this field or importing the serial number from the 
Available Microphones list.
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Nominal Sensitivity (mV/Pa)—Enter the nominal sensitivity (as assigned 
by the manufacturer) of the microphone in mV/Pa. The default value of this 
control is 50 mV/Pa. Enter the nominal sensitivity by editing this field or 
importing the value from the Available Microphones list.

Sensitivity Offset (dB)—Enter the amount (in dB) that the normal 
sensitivity of the microphone differs from its nominal sensitivity. The 
default microphone sensitivity file is set to an initial value of 0.0 dB.

Frequency Response—This graph shows the frequency response 
correction (in dB) that will be applied for each 1/3-octave band for the 
selected microphone. Frequency response corrections can only be modified 
in the Excel microphone sensitivity files, which you can load into Sound 
Power Plus by clicking Load Mics.

Cursor Information—This indicator returns the frequency response 
correction for the selected 1/3-octave band.

Assign—Click this button to launch a Microphone Configuration screen. 
This screen is described in the next section.

Cancel—Click this button to cancel your entries and exit the microphone 
configuration.
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Microphone Assignment
Figure 2-5 illustrates the Microphone Assignment window.

 

Figure 2-5.  Microphone Assignment Window

Use this window to assign your microphone to a multiplexer input channel 
(or DAQ input channel if no multiplexer is used). Access this window by 
selecting Configuration»Settings»Instrument»Microphone from the 
main menu bar and clicking the Assign button or by clicking Microphone 
and then Assign when the Instrument Configuration flowchart window is 
active.

Available Microphones—This field lists the microphones available on the 
system as configured on the previous screen. Move the slider to toggle 
through the configuration for each of the microphones.

Multiplexer Input—Select a channel from this list box to assign a 
multiplexer input channel to an available microphone.
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Auto Assign—Click this button to sequentially assign the microphones to 
input channels.

Note Always review the automatic configuration assignments to ensure that the settings 
are consistent with your current instrument or measurement configuration requirements.

OK—Click this button to accept the values and return to the main 
Instrument Configuration window.

Cancel—Click this button to ignore your changes and return to the main 
Instrument Configuration flowchart.

Select Configuration»Save»Instrument Configuration to save the 
current instrument configuration settings. A dialog box prompts you to 
enter the name of the file, and then the file is saved in Sound Power Plus 
native file format. Select Configuration»Save»Default»Instrument 
Configuration to save the current instrument configuration to the system 
instrument configuration default file Global_Instrument 
Configuration_Default.Inc. 

Configure A Sound Power Level Measurement
The following sections describe how to configure your sound power level 
(PWL) measurement. 

Load A Measurement Configuration File
You can either load configuration information into Sound Power Plus 
from a file, or enter new configuration data. To load sound power level 
measurement configuration data from a file, select Configuration» 
Load»PWL Measurement Configuration. A dialog box prompts you 
to enter the name of the file you want to load. The data in the file must be 
compatible with the current instrument configuration and the file must be 
saved in Sound Power Plus native file format. Select Configuration»
Load»Default»PWL Measurement Configuration to load the default 
sound power level measurement configuration files.

Note Sound Power Plus displays the current instrument, sound power level, and sound 
pressure level configuration files in the data window when the main program menu is active 
in the flowchart window.
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Enter New Measurement Configuration Data
To enter or change configuration data, launch the sound power level 
measurement configuration routine by selecting Configuration» 
Settings»Sound Power Level Measurement and choosing the setting 
you want to configure. The PWL Measurement Configuration flowchart 
window opens. Use this window to configure other sound power level 
measurement settings, such as:

Measurement—Configure the basic measurement parameters for a sound 
power level measurement.

Position—Configure measurement positions, assign microphones to each 
position, and configure the measurement sequence for each position.

Ambient Correction—Configure the method to use while conducting 
ambient noise corrections.

Environmental Correction—Input a series of corrections for the effect of 
the acoustic environment on the sound pressure level measurement for 
sound power, known as K2 values.

Measurement Option—Configure several measurement options 
associated with the sound power level routine.

FFT Measurement—Configure the measurement options for the source 
sound power level FFT routine and the measurement sequence of selected 
positions.

This routine is password protected. If you do have the correct password, 
you will only have read-only access to configuration options and settings.

For a more detailed explanation of configuration concepts, refer to 
Appendix A, Configuration Concepts, Protocols, and Calculations.
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Measurement Configuration
Figure 2-6 illustrates the Sound Power Level Measurement Configuration 
data window.

Figure 2-6.  Sound Power Level Measurement Configuration Data Window

Use this window to set up a sound power level measurement. You can 
access this window by selecting Configuration»Settings»Sound Power 
Level Measurement»Measurement from the main menu bar. This 
selection activates the PWL Measurement Configuration flowchart 
window, from which you can choose other measurement configuration 
options.
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Before you begin a sound power level measurement, you must select a 
measurement surfaces from the Measurement Surface list box. For 
hemi-anechoic chambers, choose a hemispherical, parallelepiped (box), 
or cylindrical measurement surface. Select a spherical measurement 
surface for full-anechoic chambers.

Note All parallelepiped measurement surfaces are assumed to be in hemi-anechoic 
environments.

Radius (m)—Choose a Hemispherical or Spherical surface to enable the 
this control. You can specify a radius from 0.50 to 4.00 meters.

Length, Width, Height—Choose a Parallelepiped surface to enable these 
controls (not shown in figure). The dimension fields follow the 
dimensioning conventions defined by ISO 7779.

Radius (m), Height (m)—Choose a Cylindrical surface to enable these 
controls.

Number of Positions—Use this text box to specify the number 
of measurement positions you want to use in your sound power 
measurement. You can assign each microphone to more than one position, 
so the number of measurement positions is not dependent on the number of 
microphones available for measurement.

Low Frequency Limit (Hz)—Use this list box to select the lowest 
measurement frequency for your sound power level measurement. 
The default measurement setup file has an initial value of 100 Hz. 
This control also sets the low limit of the range viewable in the RTA 
window.

High Frequency Limit (Hz)—Use this list box to select the highest 
measurement frequency for your sound power measurement. The default 
measurement setup file has an initial value of 20,000 Hz. This also sets the 
high limit of the range viewable in the RTA window.

Note Sound Power Plus supports measurements that fall within a frequency range of 25 to 
20,000 Hz. The Low Frequency Limit must be less than the High Frequency Limit.

OK—Click this button to accept values you entered and exit the 
measurement configuration.

Cancel—Click this button to cancel your entries and exit the measurement 
configuration.
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Position Configuration
Figure 2-7 illustrates the Sound Power Level Measurement Position 
Configuration data window.

 

Figure 2-7.  Sound Power Level Measurement Position 
Configuration Data Window

Use this window to assign a microphone configured during instrument 
configuration to each measurement position. Access this window by 
selecting Configuration»Settings»Sound Power Level Measurement» 
Position from the main menu bar or by clicking Position when the PWL 
Measurement Configuration flowchart window is active.

Position—This indicator displays a position number for each measurement 
position, as you specified in the Measurement Configuration. Use the slider 
bar to scroll through the available positions.
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Total Positions—This indicator displays the total number of positions you 
set in the Measurement Configuration window.

Microphone—Use this list box to select a configured microphone to assign 
to the measurement position. The list box lists all microphone names and 
data acquisition channels connected to the microphones, as specified in 
your system configuration. Click Auto Mic to assign microphones 
sequentially to each position.

Auto Mic—Click this button if you want to automatically assign a 
microphone to each position. Microphones are assigned according to the 
number of microphones configured on the system in the Microphone 
Configuration in relation to the number of positions configured in the 
Measurement Configuration. Microphones are assigned in sequential order 
to each position until all microphones have been assigned, and then the 
sequence repeats until all positions have been assigned.

Meas Sequence—Use this list box to enter a sequence number for sound 
pressure measurement. During ambient or source sound pressure level 
measurement, Sound Power Plus measures positions according to this 
sequence number. Positions with the same sequence number are measured 
at the same time.

Auto Seq—Click this button if you want to automatically assign a 
measurement sequence number to each position in the most logical order 
(measuring as much position at one sequence as possible).

Note Always review the automatic configuration assignments generated by the auto 
assignments (Auto Mic, Auto Seq, Auto Area, and Auto Pause) to ensure that the settings 
are consistent with your current instrument or measurement configuration requirements.

The NI 4551 device features two input channels. The device can measure 
1/3-octave band sound pressure levels ranging from 25 to 20,000 Hz on 
both channels simultaneously. 

The NI 4552 device features four input channels, and can measure 
1/3-octave band sound pressure levels ranging from 25 to 10,000 Hz 
on these four channels simultaneously. The device can also measure 
1/3-octave band sound pressure levels from 25 to 20,000 Hz on any 
two channels simultaneously.

Note The NI 4552 cannot measure 1/3-octave band sound pressure levels from 
25 to 20,000 Hz on all four of its channels simultaneously.
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Area (sq m)—Use this list box to enter a value (in square meters) for the 
surface area associated with each measurement position. This value is used 
to weigh the surface average sound pressure level (as described in 
ISO 3745, section 7.7.1.2).

Auto Area—Click this button to automatically divide the total 
measurement surface area evenly among all measurement position. If each 
measurement position in the sound power measurement is a representative 
of the same area, use this control to complete the Area field for each 
position.

Note When you click OK, the software checks the area value and measurement sequence. 
An error occurs if the sum of the areas you entered differs from the total calculated surface 
area of the measurement, as defined by the size and shape configured in the Sound Power 
Level Measurement Configuration interface, by a value greater than 0.1 dB. You must 
reconcile the individual area fields with the total measurement surface area before the 
position configuration is accepted. If positions that are assigned to the same measurement 
sequence cannot be measured at the same time (for example, if two positions use the same 
channel or exceed the board’s measurement capability), an error appears. You must check 
the measurement sequence setup and correct the sequencing to correct this error.

Pause—Select this check box to stop the measurement sequence after a 
measurement position. The measurement sequence pauses if at least one 
position in a single measurement sequence is set to Pause. Use Pause if 
you need to move a microphone to a new position between measurements. 

Auto Pause—Click this button to automatically assign pauses after each 
position based on a logical comparison between the number of 
measurement positions and the number of microphones available. For 
example, on a measurement with ten positions using two microphones, 
Sound Power Plus would automatically assign a pause to positions two, 
four, six, and eight.

Test Time—Enter the length of time (in seconds) that you want Sound 
Power Plus to measure each position. Valid values range from 1 to 
999 seconds.

Note You can override the current Pause and Test Time selections during the ambient and 
source sound pressure level measurement routines. However, you can only save these 
settings to a measurement setup file from this routine.
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Test Time for All—Enter the length of time (in seconds) in this field to set 
the test time for all measurements to the same value. 

Apply All—Click this button to apply the Test Time for All value to the 
Test Time field for each position.

All Pos. Assigned a Mic—If this indicator is green, all configured 
measurement positions are assigned to a valid microphone. This indicator 
must be green for you to save the position configuration without an error.

OK—Click this button to accept the values you entered and exit the 
position configuration.

Cancel—Click this button to cancel your entries and exit the position 
configuration.
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Ambient Correction Configuration
Figure 2-8 illustrates the Sound Power Level Measurement Ambient 
Correction Configuration data window.

 

Figure 2-8.  Sound Power Level Measurement Ambient Correction 
Configuration Data Window

Use this window to configure how ambient noise corrections are applied to 
the data. This allows the software to address several different test standards, 
all of which deal with ambient noise corrections in a different manner. You 
can access this window by selecting Configuration»Settings»Sound 
Power Level Measurement»Ambient Correction from the main menu 
bar or by clicking Ambient Correction when the PWL Measurement 
Configuration flowchart window is active.
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Ambient Correction Method—Select a method for making ambient noise 
corrections. These methods are described in detail in Appendix A, 
Configuration Concepts, Protocols, and Calculations.

• Position-by-Position—The source sound pressure level at each 
position is corrected using the ambient sound pressure level recorded 
at that position, prior to surface averaging. This option is enabled in the 
default measurement configuration file.

• Surface Average—Use the surface average ambient sound pressure 
level is then used to correct the surface averaged source sound pressure 
level.

Ambient Correction Limitation
Use this control to configure how ambient noise corrections are conducted 
when the source sound pressure level does not exceed the ambient sound 
pressure level by a limit value.

Ambient Correction Limit (dB)—Enter a value in this field for the 
difference between the source and ambient sound pressure levels, below 
which either no ambient corrections or fixed corrections are applied. The 
initial value assigned in the default measurement configuration file is 
6.0 dB.

• Correct Below Limit—Select an ambient correction method to apply 
if the difference between ambient and source sound pressure levels 
exceeds the limit you set.

• No Correction Below Limit—No correction is applied if the 
difference between source and ambient sound pressure levels is less 
than the ambient correction limit (see ISO 7779-1988, section 6.7.3).

• Apply Correction Below Limit—A fixed correction (equal to the 
correction that would be applied at the ambient correction limit) 
is applied to the source sound pressure level data if the difference 
between source and ambient sound pressure levels is less than the 
ambient correction limit (see ISO 3744-1994, section 8.3).

• No Data if Below Limit—No data is reported in bands that are within 
the ambient correction limit of the ambient sound pressure level 
(see ISO 3745-1977, section 7.6).

OK—Click this button to accept the values you entered and exit the 
ambient correction configuration.

Cancel—Click this button to cancel your entries and exit the ambient 
correction configuration.
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Environmental Correction Configuration
Figure 2-9 illustrates the Sound Power Level Measurement Environmental 
Correction data window.

 

Figure 2-9.  Sound Power Level Measurement Environmental 
Correction Data Window

Input the environmental corrections factor to apply to your sound power 
measurement into this interface. This environmental factor is referred to 
as K2 in standards such as ISO 7779 (1988, section 6.8) and ISO 3744 
(1994, section 8.4). You can access this window by selecting 
Configuration»Settings»Sound Power Level Measurement» 
Environmental Correction from the main menu bar or by clicking 
Environmental Correction when the PWL Measurement Configuration 
flowchart window is active.

Note Entries in this window are optional. The initial values assigned in the default 
measurement configuration file are 0.0 dB.
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Frequency (Hz)—A frequency is automatically provided for each 
1/3-octave band center frequency in the frequency range you set during 
Measurement Configuration. Use the slider bar to scroll through available 
frequencies.

Environmental Correction K2 (dB)—Enter a value (in dB) to be applied 
to the surface average sound pressure level in each 1/3-octave band to 
correct for the influence of the acoustic test environment.

Reset—Click this button to revert to the previously saved K2 values.

Load—Click this button to load K2 values from a measurement 
configuration file.

Save—Click this button to save the current K2 values to a measurement 
configuration file.

Note When you use the on-screen buttons, you are limited to the Save and Load functions. 
Use the menu bar to load a sound power level measurement configuration file if you want 
to load all six measurement configuration screens.

OK—Click this button to accept the K2 values you entered and exit the 
environmental corrections configuration.

Cancel—Click this button to cancel your entries and exit the environmental 
corrections configuration.
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Measurement Option Configuration
Figure 2-10 shows the Sound Power Level Measurement Option 
Configuration data window.

Figure 2-10.  Sound Power Level Measurement Option 
Configuration Data Window

Use this window to configure the measurement options for the sound power 
measurement routine. You can access this window by selecting 
Configuration»Settings»Sound Power Level Measurement» 
Measurement Option from the main menu bar or by clicking 
Measurement Option when the PWL Measurement Configuration 
flowchart window is active.

Apply Meteorological Correction (per ISO 3745)—Select this check 
box to enable the correction term based on temperature and barometric 
pressure, as defined in ISO 3745-1977, section 8.1. The data in Test 
Documentation»Meteorological Information is used to calculate this 
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correction. (For more information, see the Meteorological Information 
section in Chapter 3, Documenting Your Test.) In the default measurement 
configuration file, this option is not selected. 

Max Spread Flag—Use this list box to configure the software to specify a 
maximum limit to the difference between the maximum and minimum 
sound pressure levels as a function of the number of measurement 
positions, as required in ISO 7779-1988, section 6.6.3; ISO 3744-1994, 
section 7.2.2 and 7.3.2; and ISO 3745-1977, section 7.3.2.2. When you set 
this, an Additional Position Flag alert appears when the max spread is 
exceeded. The following options are supported:

• Equal to the Number of Measurement Positions—The Additional 
Positions Flag is set if the difference between the maximum and 
minimum sound pressure levels exceeds the number of measurement 
positions. The default sound power level measurement configuration 
file uses this option.

• Equal to Half the Number of Measurement Positions—The Additional 
Positions Flag is set if the difference between the maximum and 
minimum sound pressure levels exceeds half the number of 
measurement positions.

Express 1/3 Octave Sound Power Levels in bels—Select this option 
to calculate all 1/3-octave band sound power level results in bels 
(1 bel = 10 dB).

Express Awtd/Lin Levels in bels—Select this option to calculate the 
Awtd and linear sound power level results in bels (1 bel = 10 dB).

Note ISO 7779, ISO 3744, and ISO 3745 call for the expression of sound power levels in 
decibels (re 1 pW). However, some product declaration standards, such as ISO 9296, call 
for declaration of Awtd sound power levels in bels. Selecting one of the Express options 
allows to you work with sound power levels in bels in order to be consistent with product 
declaration standards.

OK—Click this button to accept the values you entered and exit the 
measurement options configuration.

Cancel—Click this button to cancel your entries and exit the measurement 
options configuration.
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FFT Measurement Configuration
Figure 2-11 illustrates the Source FFT Measurement Configuration data 
window.

Figure 2-11.  Source FFT Measurement Configuration Data Window

Use this window to configure parameters for measuring sound pressure 
levels at any configured microphone position using an FFT analyzer. You 
can access this window by selecting Configuration»Settings»Sound 
Power Level Measurement»FFT Measurement from the main menu bar 
or by clicking FFT Measurement when the PWL Measurement 
Configuration flowchart window is active.

Note Entries in this window are optional.

Position—An indicator that displays a position number for each 
measurement position you specified in the Measurement Configuration. 
Use the slider bar to scroll through the available positions.
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Total Positions—An indicator that displays the total number of positions 
you set during the Measurement Configuration.

Mic—An indicator that displays the microphone name that you assigned to 
this position during the Position Configuration and the data acquisition 
channel connected to each microphone after the name of each microphone.

Selected—Select a check box to designate the position or positions that 
you want to measure.

Select All—Click this button to select all measurement positions.

Meas Sequence—Use this list box to enter a sequence number for FFT 
measurement. During FFT measurement, Sound Power Plus measures 
positions according to this sequence. Positions with the same sequence are 
measured at the same time.

Auto Seq—Click this button to automatically assign a measurement 
sequence number to each position in the most logical order (measuring as 
many positions in one sequence as possible).

Note The NI 4551 and NI 4552 devices can only take simultaneous FFT measurements 
on two channels per board at a given time, regardless of the measurement frequency range.

Included in Avg—Select a check box to designate the position(s) you want 
to include in the average FFT spectrum generated by the source sound 
pressure level FFT routine.

Include All—Click this button to select all positions for inclusion in the 
average FFT spectrum.

Paused—Select this check box to stop the measurement sequence after a 
measurement position. The measurement sequence pauses if at least one 
position in a single measurement sequence is set to Pause. Use Pause if 
you need to move a microphone to a new position between measurements. 

Auto Pause—Click this button to automatically assign pauses after each 
position based on a logical comparison between the number of 
measurement positions and the number of microphones available. 

Test Time—Enter the length of time (in seconds) that you want 
Sound Power Plus to measure each position. Valid values range from 
1 to 999 seconds.
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Test Time for All—If you want to set the test time for all measurement 
positions to the same value, enter the length of time (in seconds) in this 
field.

Apply All—Click Apply All to enter the Test Time for All value into the 
Test Time field for each position.

Center Frequency—Enter the center frequency of the bandwidth to be 
analyzed by the FFT measurement. The center frequency and span controls 
are used together to set up base band or zoom-FFT measurements. For 
example, to set up a base band FFT of 20 kHz, set the center frequency to 
10,000 Hz and the span to 20,000 Hz.

Span (Hz)—Select the span of the FFT measurement, which will be 
centered on the center frequency. 

Start Freq.—This indicator displays the low frequency limit of the FFT 
measurement. The low frequency limit is determined by the 
center frequency minus one half of the span.

End Freq.—This indicator displays the high frequency limit of the FFT 
measurement. The high frequency limit is determined by the center 
frequency plus one half of the span.

OK—Click this button to accept the values you entered and exit the source 
FFT measurement configuration.

Cancel—Click this button to cancel your entries and exit the source FFT 
measurement configuration.

Select Configuration»Save»PWL Measurement Configuration to 
save the current sound power level measurement configuration settings. 
A dialog box prompts you to enter the name of the file, and the file is then 
saved in Sound Power Plus native file format. 

Select Configuration»Save»Default»PWL Measurement 
Configuration to save the current sound power level measurement 
configuration to the default sound power level measurement configuration 
file named Global_Sound Power Level_Default.PWC. 
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Configure A Operator/Bystander Sound Pressure 
Level Measurement

The following sections describe how to configure your operator or 
bystander sound pressure level (SPL) measurement.

Load A Configuration File
You can either load SPL configuration information into Sound Power Plus 
from a file, or enter new configuration data. To load SPL measurement 
configuration data from a file, select Configuration»Load»
SPL Measurement Configuration. A dialog box prompts you to enter the 
name of the file you want to load. The data in the file must be compatible 
with the current configuration and in Sound Power Plus native file 
format. Select Configuration»Load»Default»SPL Measurement 
Configuration if you want to load the default operator/bystander SPL 
measurement configuration files.

Note The current instrument, sound power level, and sound pressure level configuration 
files are displayed in the data window when the main program menu is active in the 
flowchart window.

Enter New Configuration Data
To enter new or change configuration data, launch the sound pressure level 
measurement configuration routine by selecting Configuration»Settings» 
Sound Pressure Level Measurement, then select a setting to configure. 
This launches the Sound Pressure Level Measurement Configuration 
flowchart window, from which you can configure other sound pressure 
level measurement settings. You can edit the following SPL measurement 
settings:

• Measurement—Controls and indicators that let you configure the basic 
measurement parameters for an operator/bystander sound pressure 
level measurement.

• Position—Controls and indicators that let you select operator and 
bystander measurement positions and assign microphones and 
measurement sequence numbers to each position.

• Ambient Correction—Controls and indicators that let you configure 
the method to use while conducting ambient noise corrections.

• Sound Quality—Controls and indicators that let you configure the 
options for the sound quality (impulsive and prominent tone) analysis 
routine.
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This routine is password protected. If you do not enter the correct 
password, you can browse, but not change, the current configuration 
settings.

For a more detailed explanation of configuration concepts, refer to 
Appendix A, Configuration Concepts, Protocols, and Calculations.

Measurement Configuration
Figure 2-12 illustrates the Sound Pressure Level Measurement 
Configuration data window.

Figure 2-12.  Sound Pressure Level Measurement Configuration Data Window
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Use this window to set up the operator/bystander sound pressure level 
measurement. You can access this window by selecting Configuration» 
Settings»Sound Pressure Level Measurement»Measurement from the 
main menu bar. This activates the SPL Measurement Configuration 
flowchart window, from which you can choose other configuration options.

The operator position is the position in front of the computer where a user 
would typically sit. The bystander positions are four positions around a 
piece of equipment where users might stand if the equipment does not have 
an operator position (like a server). The operator and bystander positions 
are defined in the ISO 7779 standard.

Select Position—Use the radio buttons to activate the positions you want 
to measure.

Measurement Positions—These text boxes are automatically filled in 
with positions Operator 1, Operator 2, and Bystander 1–4.

Coordinates (m)—Enter coordinates for each measurement position into 
the X, Y, and Z text boxes, using the unit set in the Unit control. The default 
measurement configuration file is set with initial values of 0.00. These 
fields are for documentation purposes only and are not used in any 
calculations.

Unit—Select the dimensions for your measurements. You can choose 
millimeter, meter, inch, or foot. Sound Power Plus automatically sets 
Dimensions to meter when you save data to a file or generate a report.

Low Frequency Limit (Hz)—Use this list box to select the lowest 
measurement frequency for the operator/bystander sound pressure level 
measurement. The default measurement configuration file is set with an 
initial value of 100 Hz. This also sets the low limit of the range you can 
view in the RTA window.

High Frequency Limit (Hz)—Use this list box to select the highest 
measurement frequency for the operator/bystander sound pressure level 
measurement. The default measurement configuration file is set with an 
initial value of 20,000 Hz. This also sets the high limit of the range you can 
view in the RTA window.

Note Sound Power Plus supports frequencies from 25 to 20,000 Hz. The Low Frequency 
Limit must be less than the High Frequency Limit.

OK—Click this button to accept the values you entered and exit the 
measurement configuration.
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Cancel—Click this button to cancel your entries and exit the measurement 
configuration.

Position Configuration
Figure 2-13 illustrates the Sound Pressure Level Measurement Position 
Configuration data window.

 

Figure 2-13.  Sound Pressure Level Measurement Position 
Configuration Data Window

Use this window to assign a configured microphone to each measurement 
position which must be assigned a measurement sequence and to set the 
measurement parameters. You can access this window in the following 
ways by selecting Configuration»Settings»Sound Pressure Level 
Measurement»Position from the main menu bar or by clicking Position 
when the SPL Measurement Configuration flowchart window is active.
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Position—This box lists each measurement position you selected in the 
Measurement Configuration.

Microphone—Use this list box to select a configured microphone to assign 
to the measurement position. The list box lists all microphone names and 
data acquisition channels connected to the microphones, as specified in 
your system configuration. Click Auto Mic to assign microphones 
sequentially to each position.

Auto Mic—Click this button if you want to automatically assign a 
microphone to each position. Microphones are assigned according to the 
number of microphones configured on the system in the Microphone 
Configuration in relation to the number of positions configured in the 
Measurement Configuration. Microphones are assigned in sequential order 
to each position until all microphones have been assigned, and then the 
sequence repeats until all positions have been assigned.

Meas Sequence—Use this list box to enter a sequence number for sound 
pressure measurement. During ambient or source sound pressure level 
measurement, Sound Power Plus measures positions according to this 
sequence number. Positions with the same sequence number are measured 
at the same time.

Auto Seq—Click this button if you want to automatically assign a 
measurement sequence number to each position in the most logical order 
(measuring as much position at one sequence as possible).

Note Always review the automatic configuration assignments generated by the auto 
assignments (Auto Mic, Auto Seq and Auto Pause) to ensure that the logic applied is 
consistent with your current instrument or measurement configuration requirements.

Pause—Select this check box to stop the measurement sequence after a 
measurement position. The measurement sequence pauses if at least one 
position in a single measurement sequence is set to Pause. Use Pause if 
you need to move a microphone to a new position between measurements.

Auto Pause—Click this button to automatically assign pauses after each 
position based on a logical comparison between the number of 
measurement positions and the number of microphones available. For 
example, on a measurement with ten positions using two microphones, 
Sound Power Plus would automatically assign a pause to positions two, 
four, six, and eight.
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Test Time—Enter the length of time (in seconds) that you want 
Sound Power Plus to measure each position. Valid values range 
from 1 to 999 seconds.

Test Time for All—Enter the length of time (in seconds) in this field to set 
the test time for all measurements to the same value. 

Note You can override the current Pause and Test Time selections during the ambient and 
source sound pressure level measurement routines. However, you can only save these 
settings to a measurement setup file from this routine.

Apply All—Click the Apply All button to enter the Test Time for All 
value in the Test Time field for each position.

OK—Click this button to accept the values you entered and exit the 
position configuration.

Cancel—Click this button to cancel your entries and exit the position 
configuration.
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Ambient Correction Configuration
Figure 2-14 illustrates the Sound Pressure Level Measurement Ambient 
Correction Configuration data window.

 

Figure 2-14.  Sound Pressure Level Measurement Ambient Correction 
Configuration Data Window

Use this window to configure how ambient noise corrections are applied to 
the data. You can access this window in the following ways by selecting 
Configuration»Settings»Sound Pressure Level Measurement»
Ambient Correction from the main menu bar or by clicking Ambient 
Correction when the SPL Measurement Configuration flowchart window 
is active.

In the operator/bystander sound pressure level routine, all ambient noise 
corrections are applied on a position-by-position basis.
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Ambient Correction Limit—Enter a value for the difference between the 
source and ambient sound pressure levels, below which either no ambient 
corrections are applied or a fixed correction is applied. The default 
measurement configuration file has an initial value of 6.0 dB.

Apply Correction Below Limit—Select this check box to apply a fixed 
correction (equal to the correction that would be applied at the correction 
limit) to the source sound pressure level data. Select this option if the 
difference between the source and ambient sound pressure levels is less 
than the ambient correction limit.

OK—Click this button to accept the values you entered and exit the 
ambient correction configuration.

Cancel—Click this button to cancel your entries and exit the ambient 
correction configuration.
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Sound Quality Analysis Configuration
Figure 2-15 illustrates the Sound Pressure Level Measurement Sound 
Quality Analysis Configuration data window.

 

Figure 2-15.  Sound Pressure Level Measurement Sound Quality 
Analysis Configuration Data Window

Use this window to configure the analysis options for the sound quality 
measurements. You can access this window in the following ways by 
selecting Configuration»Settings»Sound Pressure Level 
Measurement»Sound Quality from the main menu bar or by clicking 
Sound Quality Analysis when the SPL Measurement Configuration 
flowchart window is active.

Prominence Ratio Criteria Level—Enter a value (in dB) above which 
you want a tone analyzed by the prominence ratio method to be flagged as 
being prominent. An indicator is lit if the ratio exceeds the criteria level. 
This indicator is in the Prominent Tone Analysis data window. The default 
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measurement configuration file is set with an initial value of 7.0 dB 
(see ECMA-74, 1997).

Tone to Noise Ratio Criteria Level—Enter a value (in dB) above which 
you want a tone analyzed by the tone-to-noise ratio method to be flagged 
as being prominent. Impulsive sounds are noted by a orange indicator on 
the position in the Source SPL measurement routine. The default 
measurement configuration file is set with an initial value of 6.0 dB 
(see ISO 7779-1988, Annex D, paragraph D.4.5).

Note Tones are automatically analyzed using both the tone-to-noise and prominence ratio 
methods each time a tone is selected. Indicators provide analysis results for both methods.

Impulsive Criteria Level—Enter a value (in dB) above which you want 
the difference between the impulse A-weighted sound pressure level and 
the A-weighted sound pressure level to cause the measurement position 
to be flagged as being impulsive. The default measurement configuration 
file is set with an initial value of 3.0 dB (see ISO 7779, Annex D, 
paragraph D.3.2).

FFT Averaging Time—Enter a value (in seconds) to use as the 
FFT measurement time while conducting the prominent tone analysis.

OK—Click this button to accept the values you entered and exit the sound 
quality analysis configuration.

Cancel—Click this button to cancel your entries and exit the sound quality 
analysis configuration.

Select Configuration»Save»SPL Measurement Configuration to 
save the current operator/bystander sound pressure level measurement 
configuration data (including sound quality configuration). A dialog box 
prompts you to enter the name of the file. The file is then saved in the Sound 
Power Plus native file format. Select Configuration»Save»Default»
SPL Measurement Configuration if you want to save the current 
operator/bystander sound pressure level measurement configuration to the 
system sound pressure level measurement configuration default file 
Global_Sound Pressure Level_Default.SPC. 
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Auto-Ranging Configuration
Figure 2-16 illustrates the Auto Ranging Configuration data window.

 

Figure 2-16.  Auto Ranging Configuration Data Window

Use this window if you want to automatically set the input range for your 
instruments based on the sampled signal level. You can access this window 
by selecting Configuration»Settings»Auto Ranging from the main menu 
bar.

Enable Auto-Ranging—Select this check box if you want to enable 
auto-ranging on all measurements. When selected, the remaining 
auto-ranging controls are enabled and the system will automatically 
determine the proper input range based on the settings you selected. If you 
do not select this check box, the instrument is automatically set to the 
default range. If you do not want to use the default range, you must set the 
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instrument range before each measurement. This is done from the RTA or 
FFT display window.

Auto Ranging Time (sec)—Enter the length of time (in seconds) you want 
the system to sample the input signal to automatically determine the proper 
input range.

Auto Range Before—Sound Power Plus supports two auto-ranging 
options:

• Each Measurement—When you select this option, the software 
automatically ranges the instrument before each measurement activity, 
which can include sampling several positions. For example, the 
instrument would auto-range once before making all ten sound 
pressure level measurements of a ten-position measurement activity. 

• Each Position—When you select this option, the software 
automatically ranges the instrument before taking a measurement at 
each position.

Confirm Range After Auto-Ranging—When you select this option, you 
will have the opportunity to confirm or change the automatically selected 
input range before the measurement proceeds.

Default Range—If auto-ranging is not enabled, this value determines the 
range that the instrument defaults to before each measurement routine.

Default Auto Ranging Position—If auto-ranging is enabled, all the 
positions with the same sequence as Default Auto Ranging Position are 
used as the auto ranging positions before each measurement.

OK—Click this button to accept the values you entered and exit the 
auto-ranging configuration.

Cancel—Click this button to cancel your entries and exit the auto-ranging 
configuration.
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3
Documenting Your Test

Sound Power Plus lets you document each test you conduct. To access the 
test documentation functions, select the Test Documentation button from 
the Main Menu. The Test Documentation flowchart appears. The 
following sections describe the process you use to document the test and 
equipment. 

Note Test Name and Operation Mode are required documentation fields for all tests.
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Test Information
Figure 3-1 illustrates the Test Documentation data window.

Figure 3-1.  Test Documentation Data Window

Use this window to record information about the test being conducted. You 
can access this window by selecting Main Menu»Test Documentation in 
the flowchart window, then clicking on the Test Information button.

Test Name—Enter a unique series of letters and/or numbers that identify 
the test. The software uses the test name as part of a suggested file name 
when you save and export to a file. This is a required field.

Note The suggested file name for saving tests is Test Name_Operation Mode.MEA.

Date/Time—Enter the date and time the test was conducted. 
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Current—Click the Current button if you want to enter the current date 
and time in the Date/Time field.

Operator—Enter the name of the operator who conducted the test.

Description—Enter a general description of the test.

Comments—Enter comments about the test.

OK—Click this button to accept the values you entered and exit the test 
information documentation.

Cancel—Click this button to cancel your entries and exit the test 
information documentation.
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Source Information
Figure 3-2 illustrates Sound Power Plus with the Source Documentation 
data window active.

Figure 3-2.  Source Documentation Data Window

Use this window to record information about the source being tested. You 
can access this window by selecting Main Menu»Test Documentation in 
the flowchart window, then clicking on the Source Information button.

Source Type—Select the type of device being tested. You can modify 
several common source types which are saved in the configuration file 
/Data/Test Information.ini. These source types are loaded into the 
list box before you access this window. If you do not find an operation 
mode suitable for the device you are testing, select Other from the 
Source Type list box to enter the name of your operation mode.
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Other Source—Enter the name of your source type. This control appears 
if you selected ‘other...’ for Source Type.

Manufacturer—Enter the manufacturer of the device you are testing.

Model Number—Enter the model number of the device you are testing.

Serial Number—Enter the serial number of the device you are testing.

Operation Mode—Select the operation mode of the device you are testing. 
You can modify several common operation modes which are saved in the 
configuration file /Data/Test Information.ini. These operation 
modes are loaded into the list box before you access this window. If you do 
not find an operation mode suitable for the device you are testing, select 
Other from the Operation Mode list box to enter the name of your 
operation mode.

Other Mode—Enter the name of a new operation mode. Enable the Other 
Mode list box by selecting Other in the Operation Mode list box.

Note The suggested file name for saving tests is Test Name_Operation Mode.

Mounting—Enter how the device was mounted during the test.

Dimensions—Enter the Length, Width, and Height measurements of the 
device, using the units selected in Unit control.

Unit—Select the measurement unit for your dimensions. You can choose 
millimeter, meter, inch or foot. Sound Power Plus automatically sets 
Dimensions to millimeter when you save the data to files or generate 
reports.

Voltage (V)—Enter the voltage at which you operated the device you are 
testing.

Current (A)—Enter the current draw for the device you are testing. 

Line Frequency (Hz)—Enter the line frequency at which you operated the 
device you are testing.

RPM—Enter the RPM of the device you are testing.

OK—Click this button to accept the values you entered and exit the source 
information documentation.
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Cancel—Click this button to cancel your entries and exit the source 
information documentation.

Meteorological Information
Figure 3-3 illustrates Sound Power Plus with the Meteorological 
Documentation data window active.

 

Figure 3-3.  Meteorological Documentation Data Window

Use this window to record information about meteorological conditions 
in the test chamber during the test. Data entered in this form is used to 
calculate the meteorological correction term, if this option is enabled in 
the Measurement Options configuration. You can access this window by 
selecting Main Menu»Test Documentation in the flowchart window, then 
clicking on the Meteorological Information button.
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Temperature—Enter the temperature (in degrees Celsius or Farenheit) in 
the test chamber at the time of the test.

Temperature Units—Select the units for the temperature value indicated 
in the Temperature field. Sound Power Plus automatically 

Relative Humidity (%)—Enter the relative humidity (in percent) in the 
test chamber at the time of the test.

Barometric Pressure—Enter the barometric pressure (in kPa, hPa, 
mmHg, or mBar) at the time of the test. Sound Power Plus automatically 
converts pressure values to kPa when you save data to a file or generate a 
report. 

Barometric Pressure Units—Select the units for the barometric pressure 
value. Choose from kPa, HPa, mmHg, or millibars. Sound Power Plus 
automatically converts pressure values to kPa when you click OK.

OK—Click this button to accept the values you entered and exit the 
meteorological information documentation.

Cancel—Click this button to cancel your entries and exit the 
meteorological information documentation.
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User Information
Figure 3-4 illustrates Sound Power Plus with the User Documentation data 
window active.

 

Figure 3-4.  User Documentation Data Window 

This window provides six user-definable fields that you can use to 
document custom information about the device being tested. Use the User 
Fields to define the field names and the Field Data to record the data for 
the device being tested. These fields can be renamed from test to test to 
capture data that is specific to the type of device being tested. You can 
access this window by selecting Main Menu»Test Documentation in 
the flowchart window, then clicking on the User Information button.

User Field n—The name you assign to the nth user field.

Field n data—The data associated with User Field n.
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OK—Click this button to accept the values you entered and exit the user 
information documentation.

Cancel—Click this button to cancel your entries and exit the user 
information documentation.

Save Documentation
Test documentation data is saved along with the sound power or sound 
pressure level test data when you save the test data files. Select File»
Save Measurement to save the current test documentation. A dialog box 
prompts you to enter the name of the file. The file is then saved in the 
Sound Power Plus native file format. 

Test documentation is reloaded into Sound Power Plus when a test file 
is loaded. To load a data file, select File»Load Measurement. Test 
documentation is also exported when you export data to Excel or text files.
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4
Calibrate Your Microphones

Sound Power Plus includes a calibration routine to calibrate and monitor 
the calibration sensitivity of the system microphones. This calibration 
routine is accessible from either the sound power or sound pressure level 
measurement flowchart.

Sound Power Plus supports manual and automatic calibration routines. 
The manual calibration routine calibrates each microphone sequentially, 
requiring you to control the software after each microphone is calibrated. 
The auto-calibration routine automatically scans the microphones for a 
calibration signal, calibrates the microphone, and automatically begins 
scanning for another microphone with a calibration signal. The software 
provides audible prompts which indicate that a microphone has been 
calibrated or that a microphone has been scanned and a calibration signal 
was not detected. The calibration configuration routine provides several 
control options for the auto-calibration routine.

Calibration Routine Logic
The calibration routine works using the following logic:

1. The nominal sensitivity of each microphone is passed from the 
microphone data file to the DSA board before the calibration begins.

2. The calibration measurement is performed. The system generates an 
actual sensitivity offset (in dB) required to cause the microphone to 
read the calibration level.

3. The system uses the actual sensitivity offset (in dB) to calculate the 
actual sensitivity of the microphone (in mV/Pa). Prior to all 
measurements with this microphone, the actual sensitivity calculated is 
passed to the DSA board and is displayed in the alphanumeric display 
on the RTA window.

4. A value for the normal sensitivity offset required for the microphone 
is  stored in the microphone data file. The actual sensitivity offset 
generated during the calibration measurement is compared to this 
normal sensitivity offset and a difference is generated. This difference 
is compared to the maximum allowed sensitivity variation that you set 
in the calibration parameters.
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5. During the calibration process, the calibration routine plots the amount 
the actual sensitivity offset differs from the normal sensitivity offset. 
You can set a maximum allowed sensitivity variation in the Calibration 
Configuration parameters. Microphones that calibrate outside of the 
allowed sensitivity variation appear outside the control range on the 
graph.

Example
A microphone with a nominal sensitivity of 50 mV/Pa and an actual 
sensitivity of 45 mV/Pa has a normal sensitivity offset of 
20 log (45/50) = –0.9 dB.

If, when this microphone is calibrated, a –1.3 dB gain adjustment is 
required, then the microphone differs by –0.4 dB (–1.3 – (–0.9) = –0.4 dB). 
If the allowable sensitivity variation has been set to 0.3 dB, the calibration 
level for this microphone is displayed as being outside of the control range 
on the calibration control chart.

Configuring Calibration
The following sections describe how to configure your microphone 
calibration.

You can either load calibration data into Sound Power Plus from a file, 
or enter new calibration data. To load calibration data from a user-named 
file into the microphone calibration data, select Calibration»
Load Calibration Data. A dialog box prompts you to enter the name of 
the file you want to load. The data in the file must match the number of 
microphones currently configured for the system; otherwise, an error is 
returned. The file must be in Sound Power Plus native file format.

To enter or change calibration data, launch the calibration configuration 
routine by selecting Calibration»Settings. This launches the Calibration 
Configuration data window, which lets you change calibration parameters 
and auto-calibration settings. 
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Figure 4-1 illustrates Sound Power Plus with the Calibration Configuration 
data window active.

 

Figure 4-1.  Calibration Configuration Data Window

Use this window to configure the microphone calibration parameters 
and auto-calibration options. You can access this window by selecting 
Calibration»Settings from the main menu bar.

Calibration Parameters
Calibration Frequency (Hz)—The 1/3-octave band center frequency 
of the calibrator (in Hz).

Calibration Level (dB)—The sound pressure level generated by the 
calibrator at the calibration frequency (in dB re 2E-5 Pa).
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Calibration Averaging Time (s)—The length of the time sample 
(in seconds) that will be averaged when performing a calibration 
measurement.

Allowed Sensitivity Variation (dB)—Defines the limits to be applied to 
the calibration control chart (which is visible when you perform the 
Microphone Calibration in the next section). This value is the maximum 
amount (in dB) that the actual sensitivity offset of the microphone may 
differ from the normal sensitivity offset of the microphone before the 
calibration control chart indicates that the calibration is out of range.

Auto-Calibration Options

Positive WAV File—A .wav sound file that the system sound card plays 
whenever the software detects a valid calibration signal during the 
auto-calibration routine. You can assign any .wav-format file.

Negative WAV File—A .wav sound file that the system sound card plays 
whenever the software fails to detect a valid calibration signal during the 
auto-calibration routine. You can assign any .wav-format file.

Pause After Calibration—The duration (in seconds) the system pauses 
after scanning a microphone for a calibration tone before proceeding to 
scan the next microphone. This delay is useful if you need to move the 
calibrator to a new microphone between calibrations. A delay of two to five 
seconds is usually sufficient for most microphone layouts.

Scan Method—Two scanning methods are supported by the software:

• Scan Until Calibrated—The auto-calibration routine scans the 
microphone for a calibration tone. If no tone is detected, the software 
pauses, then scans the microphone again. This process is repeated until 
a calibration tone is detected. The microphone is then calibrated, the 
software pauses, then proceeds to the next microphone.

• Sequential Scan—The auto-calibration routine scans the microphone 
for a calibration tone. If no tone is detected, the software pauses, then 
proceeds to scan the next microphone.

OK—Click this button to accept the values you entered and exit the 
calibration configuration.

Cancel—Click this button to cancel all entries and exit the calibration 
configuration.

Note Calibration settings are saved with the instrument configuration settings. 
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Microphone Calibration
Figure 4-2 illustrates Sound Power Plus with the Sound Power Level 
Measurement Microphone Calibration Configuration data window active. 

Note The sound pressure level calibration routine works like the sound power level 
calibration routine, except that the microphones that are displayed for calibration are the 
microphones you configured during the sound pressure level measurement configuration.

Figure 4-2.  Sound Power Level Measurement Microphone Calibration 
Configuration Data Window

Use this window to calibrate your microphone(s). You can access this 
window by selecting Main Menu»Sound Power Level Measurement 
in the flowchart window, then clicking on the Calibration button.
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Calibrate All—Click this control if you want to activate a calibration 
routine that sequentially calibrates all configured microphones. 
The Calibrate All routine calibrates a microphone, then prompts you to 
move the calibrator to the next microphone. Click Continue to calibrate 
the next microphone. This sequence continues through all configured 
microphones.

Auto Calibrate—Click this button if you want to automatically scan all 
microphones for a calibration tone. If a calibration tone is found, the system 
stops to calibrate the microphone. If no calibration tone is found, the 
scanning continues in accordance with the scanning method you configured 
in the Calibration Configuration. Audible feedback lets you know when a 
microphone has been successfully calibrated and when no calibration tone 
is detected.

Calibrate Selected—This procedure operates like Calibrate All, but it 
only scans and calibrates the microphone(s) that have been selected in the 
Microphone Selection box. 

Microphone Selection
The list box on the right side of the screen shows all microphones currently 
configured and selected for the measurement. You can select any 
microphone in the list by clicking on the microphone name. To select 
multiple microphones, press <Shift> while you select the microphone 
names. Selection of microphones in this manner is used in conjunction with 
the Calibrate Selected control. Clicking on a single microphone in this list 
also displays its calibration parameters under the Calibration Control 
chart.

Calibration Configuration Parameters
A list of the current calibration parameters is displayed below the 
Microphone Selection list. This list displays the currently configured 
calibration frequency, calibration level, allowed sensitivity variation, 
auto-calibration sequence logic, and pause time. For more information on 
these options, refer to the Configuring Calibration section of this chapter.

Calibration Control Chart
The Calibration Control chart displays the calibration status of each 
system microphone as it is calibrated. A control range is established 
based on the allowed sensitivity variation you set in the Calibration 
Configuration. The 0 dB level for each microphone is based on the normal 
sensitivity offset for the microphone. The value displayed in this chart 
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represents the amount the actual sensitivity offset obtained during the 
calibration measurement differs from the normal sensitivity offset recorded 
in the microphone sensitivity data file.

Out of Range—If the Actual Sensitivity Offset differs from the Normal 
Sensitivity Offset by more than the Allowed Sensitivity Variation, the 
indicator point for the sensitivity of the microphone is shown in red. The 
value displayed on the control chart is the amount (in dB) by which the 
Actual Sensitivity Offset differs from the Normal Sensitivity Offset for 
the microphone.

Calibration—If the Actual Sensitivity Offset differs from the Normal 
Sensitivity Offset by less than or equal to the Allowed Sensitivity 
Variation, the indicator point for the sensitivity of the microphone is shown 
in green. The value displayed on the control chart is the amount (in dB) by 
which the Actual Sensitivity Offset differs from the Normal Sensitivity 
Offset for the microphone.

Expected—The Expected value is indicated by the open green circles 
along the 0 dB line. All microphones are displayed with an Expected value 
of 0.0 dB, as they are normalized such that the Normal Sensitivity Offset 
of the microphone is indicated by a 0.0 dB calibration value.

Up Limit/Low Limit—The upper and lower limits of the control chart (the 
allowed sensitivity variation (in dB) from the 0.0 dB Expected level) are 
displayed in dark green. Red data points displayed in these areas indicate 
that the Actual Sensitivity Offset of the microphone determined during the 
calibration exceeds the Normal Sensitivity Offset of the microphone by 
more than the allowed sensitivity variation.

OK—Click this button to accept the values you entered and exit the 
microphone calibration.

Cancel—Click this button to cancel your entries and exit the microphone 
calibration.

Save Calibration Data
Select Calibration»Save Calibration Data to save the current 
microphone calibration data. A dialog box prompts you to enter the name 
of the file. This file is then saved in the Sound Power Plus native file 
format.
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5
Sound Power Level 
Measurement

The following sections describe how to measure the sound power level. 
Before you make a sound power level measurement, make sure you have 
valid instrument and sound power level measurement configuration 
settings. Refer to the Configuring Your Instruments and Configure A Sound 
Power Level Measurement sections in Chapter 2, Installation and 
Configuration, for more information.

You can either load measurement data into Sound Power Plus from a file, 
or acquire new measurement data. To load measurement data from a file, 
select File»Load Measurement. A dialog box prompts you to enter the 
name of the file you want to load. The measurement file must match 
the current measurement configuration; otherwise, an error is returned. 
The data must be in Sound Power Plus native file format.

Note The current instrument, sound power level, and sound pressure level configuration 
files are displayed in the data window when the main program menu is active in the 
flowchart window.

To begin taking sound power level measurements, click the Sound Power 
Level Measurement button on the main flowchart menu. This launches the 
PWL Measurement flowchart window, from which you can make 
measurements.

Calibration
Click the Calibration button to calibrate and monitor the calibration of 
the system microphones. This routine is the same in the sound power level 
measurement flowchart and the sound pressure level measurement 
flowchart. The calibration routine is described in detail in Chapter 4, 
Calibrate Your Microphones.
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Ambient SPL Measurement
Figure 5-1 illustrates Sound Power Plus with the Ambient SPL 
Measurement data window active.

 

Figure 5-1.  Ambient SPL Measurement Data Window

Use this window to measure and review the ambient sound pressure 
level data. You can access this window by selecting Main Menu»
Sound Power Level Measurement in the flowchart window, and clicking 
the Ambient SPL Measurement button.

Select—Select a check box to designate the position(s) you want to 
measure with the Meas Selected or One Apply to All buttons.

Pause/Proceed—This control determines whether a measurement pauses 
or proceeds after completing each measurement sequence. A pause in your 
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measurement sequence is useful when you need to make changes to your 
setup, such as moving a microphone to a different position.

If any of the controls in a sequence are set to Pause, a prompt appears at the 
end of the sequence. If all of your controls are set to Proceed, Sound Power 
Plus starts the next measurement sequence immediately after the current 
sequence completes.

Overload Indicator—Indicates with a red indicator whether an overload 
occurred on the input of the DAQ board as the data was acquired. If an 
overload occurs during an automated measurement sequence, the software 
attempts to measure the position again before setting the indicator and 
proceeding. Data with overload indicators set might introduce errors in 
analysis.

OK Indicator—Indicates with a green indicator whether the data for that 
position was acquired without overload and if there is valid data for all 
bands.

Data Table—Ambient sound pressure level data is displayed in the data 
table as it is obtained. The Awtd sound pressure level is displayed in the first 
column. This table has scroll bars that let you browse the entire data table. 
The yellow background of the unmeasured positions changes to green after 
the measurement is complete.

Note The background color of the data table indicates whether the data in the data table is 
current data or if it was measured during an earlier visit to this menu. A yellow background 
indicates that the data was measured during an earlier visit, while a green background 
indicates that the data is from the current visit.

Measure All—Click this button to sample each measurement position, 
beginning with Sequence 1 and continuing through the last sequence. 
Measure All pauses if any of the controls in the current sequence are set to 
Pause.

Meas Selected—Click this button to sample each selected measurement 
position, starting with the first position and proceeding through all 
measurement sequences until all selected positions are measured. Meas 
Selected pauses if any of the controls in the current sequence are set to 
Pause.

Note Sound Power Plus can measure multiple positions at the same time according to the 
Position Configuration of the measurement. Refer to the Configure A Sound Power Level 
Measurement section in Chapter 2, Installation and Configuration, for more information.
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One Apply to All—Click this button to make a single sound pressure level 
measurement at a selected position and copy the measurement result to all 
positions in the data table. If you select more than one position, the routine 
measures the first selected position and clears all additional selections.

Measurement Time—If you want to temporarily override the 
measurement time you set up for each microphone in the Position 
Configuration, enter the length of time (in seconds) you want the system 
to sample each position and select Apply All. The measurement 
configuration file in use is not changed.

Apply to All—Use this control to apply Measurement Time to 
all microphones during this measurement session.

All Measured—Indicates whether there is valid data for each configured 
position.

OK—Click this button to accept the data as it is displayed in the current 
data table and exit the ambient noise measurement routine.

Cancel—Click this button to return the data to the state it was when you 
last clicked OK and to exit the ambient noise measurement routine.

The status indicator at the bottom of this data window indicates the current 
status of the DAQ board. Status values are Ready or Acquire. When you 
are acquiring data, a status bar indicates the progress of the measurement.
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Source SPL Measurement
Figure 5-2 illustrates Sound Power Plus with the Source Sound Pressure 
Measurement data window active.

 

Figure 5-2.  Source Sound Pressure Measurement Data Window

Use this window to measure source sound pressure levels. You can access 
this window by selecting Main Menu»Sound Power Level Measurement 
in the flowchart window and clicking Source SPL Measurement.

Note Many of the functions in this window are similar to those outlined for ambient sound 
pressure level measurement. 

Select—Select the position(s) you want to measure using the Measure 
Selected control.
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Pause/Proceed—This control determines whether a measurement pauses 
or proceeds after completing each measurement sequence. A pause in your 
measurement sequence is useful when you need to make changes to your 
setup, such as moving a microphone to a different position.

If any of the controls in a sequence are set to Pause, a prompt appears at the 
end of the sequence. If all of your controls are set to Proceed, Sound Power 
Plus starts the next measurement sequence immediately after the current 
sequence completes.

Overload Indicator—If the red indicator next to a position is lit, an 
overload occurred on the input of the DAQ board as the data was being 
acquired. Data with overload indicators set might introduce errors in 
analysis.

Data Table—Source sound pressure level data is displayed in the data 
table as it is obtained. The Awtd sound pressure level is displayed in the first 
column. This table has scroll bars that let you browse the entire data table. 
The yellow background of the unmeasured positions changes to green after 
the measurement is complete.

Note The background color of the data table indicates whether the data in the data table is 
current data or if it was measured during an earlier visit to this menu. A yellow background 
indicates that the data was measured during an earlier visit, while a green background 
indicates that the data is from the current visit.

Measure All—Click this button to sample each measurement position, 
beginning with Sequence 1 and continuing through the last sequence. 
Measure All pauses if any of the controls in the current sequence are set to 
Pause.

Meas Selected—Click this button to sample each selected measurement 
position, starting with the first position and proceeding through all 
measurement sequences until all selected positions are measured. Meas 
Selected pauses if any of the controls in the current sequence are set to 
Pause.

Note Sound Power Plus can measure multiple positions at the same time according to the 
Position Configuration of measurement. Refer to the Configure A Sound Power Level 
Measurement section in Chapter 2, Installation and Configuration, for more information.

Measurement Time—If you want to temporarily override the 
measurement time you set for each microphone in the Position 
Configuration, enter the length of time (in seconds) you want the system 
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to sample each position and select the Apply All check box. The 
measurement configuration file in use is not changed.

Apply All—Select this check box to apply the Measurement Time to all 
microphones during this measurement session.

Max Spread Exceeded—Indicates if the difference between the maximum 
and minimum sound pressure levels in any band exceeds the number of 
microphone positions, depending on the max spread flag option you 
selected in Measurement Option Configuration.

Overload—Notifies you if an overload indicator is present at any position 
at the end of a measurement sequence with a red light. 

Spread—This indicator is lit when the Max Spread Exceeded indicator is 
lit for any frequency band.

All Measured—A green All Measured indicator represents valid data for 
each configured position.

Export Data—Click this button to export source sound pressure data to 
Excel. After selecting an Excel file as your template file, select a worksheet 
from the list box as the destination for your exported data. If you do not 
select Save To A New File, the data will be exported to the template file.

View FFT Controls—Click this button to view the Source FFT 
Measurement data window, which you can use to conduct measurements 
and view the results of the FFT positions. For more information, refer to the 
FFT Measurement section.

OK—Click this button to accept the data as displayed in the current data 
table and exit the source sound measurement routine.

Cancel—Click this button to return the data to the state it was in the last 
time you clicked on the OK button and exit the source sound measurement 
routine.
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Exporting Data
Figure 5-3 illustrates the Export Source Sound Pressure window. This is an 
intermediate export of sound pressure level provided by Source Sound 
Pressure level measurement of Sound Power Level Measurement.

Figure 5-3.  Export Source Sound Pressure Window

You can access this window by clicking Export Data to activate the Export 
to Excel dialog box. This dialog box allows you to select an Excel 
workbook file and worksheet into which the data will be exported.

Select File to display a list of template files for data export. The Worksheet 
control displays a list of the worksheets contained in the template file. 
If you select one of the Worksheet names and click Save, the current Source 
Sound Pressure Level data is exported into the upper left corner (cell A1) 
of the Excel workbook, overwriting any existing data in that cell.

Select Save to a new file to open an additional dialog box that you can use 
to rename the Excel file.

Select Leave Excel open to leave Excel open once the data export is 
complete.

The ability to export data is a powerful tool that allows you to use the 
multi-channel RTA to conduct many custom acoustical tests based on a 
series of 1/3-octave band sounds pressure level measurements. You can 
create template files in advance to quickly export data and provide data 
analysis immediately after the export is complete.
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Note If you want to export measurement data from a single Excel file multiple times, 
select the target file as your template and select worksheets in the Worksheets control for 
exporting data. You can then save data to the file without selecting Save to a new file. 
If you want to edit the Excel file for export at a later time, save the file before exporting 
data to it. If you export data to an open Excel workbook without first saving any 
modifications to existing data, you will receive an error message.

FFT Measurement
Figure 5-4 illustrates Sound Power Plus with the Source FFT Measurement 
data window active.

Figure 5-4.  Source FFT Measurement Data Window

Use this window to conduct measurements and view the results of the FFT 
positions you configured for sound power level measurement. The routine 
also provides an average FFT spectrum that can be configured to calculate 
and display the average of the FFT spectra at any or all of the measurement 
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positions. You can access this window by selecting Main Menu»
Sound Power Level Measurement»Source SPL Measurement in 
the flowchart window, then clicking the View FFT Controls button.

Note The FFT source sound pressure level routine is not required by ISO 7779 and is not 
a fundamental part of the sound power test. The 1/3-octave band sound power level test 
results are generated even if no FFT data is acquired.

By default, the configuration parameters on this screen are pulled from the 
current source sound power level FFT measurement configuration. The 
values can be changed (but not saved) during the current measurement 
session.

Pause/Proceed—This control determines whether a measurement pauses 
or proceeds after completing each measurement sequence. A pause in your 
measurement sequence is useful when you need to make changes to your 
setup, such as moving a microphone to a different position.

If any of the controls in a sequence are set to Pause, a prompt appears at the 
end of the sequence. If all of your controls are set to Proceed, Sound Power 
Plus starts the next measurement sequence immediately after the current 
sequence completes.

Selected—Select a check box to designate the position(s) you want to 
measure with the Measure Selected button.

Overload Indicator—If the red indicator next to a position is lit, an 
overload occurred on the input of the DAQ board as the data was being 
acquired. Data with overload indicators set might introduce errors in 
analysis.

Measured Indicator—If the green Measured indicator is lit, there is valid 
data for the position.

Select for Display—Click the position(s) you want to be displayed on the 
FFT display. 

Center Frequency—This control lets you set the center frequency for the 
FFT spectrum to be measured.

Span—This control lets you set the frequency range span for the FFT 
measurement. The span will be centered around the Center Frequency.
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Note Changes you make to Center Frequency and Span will be remembered as 
configuration, but will not be saved to the configuration file. Changes to Measurement 
Time apply to only the current measurement session. Changes to default or named 
Measurement Configuration files can only be made in Sound Power Level Measurement 
Configuration.

Measurement Time—If you want to temporarily override the 
measurement time you set for each microphone in the Position 
Configuration, enter the length of time (in seconds) you want the system 
to average the FFT at each position. 

Apply All—Select this check box to apply the Measurement Time to all 
positions during this measurement.

Display Selected—Select this check box if you want to display the 
positions selected in the Select for Display field. 

Display Average—Select this check box if you want to display the average 
FFT spectrum of the positions selected for inclusion in the average FFT 
spectrum. 

Overload—If an overload indicator is present at any position at the end of 
a measurement sequence, this indicator lights red.

All Measured Indicator—If the green All Measured indicator is lit, there 
is valid data for each configured position.

Measure All—Click this button to conduct an FFT at each measurement 
position, beginning with Measurement Sequence 1 and continuing through 
the last measurement sequence. This sequence pauses if the 
Paused/Proceed button is in the Paused mode.

Measure Selected—Click this button if you want to conduct an FFT at 
each selected measurement position, starting with the first selected position 
and proceeding through all selected positions. This sequence pauses if the 
Paused/Proceed button is in the Paused mode.

Note Sound Power Plus can measure multiple positions at the same time according to 
Position Configuration of measurement. Refer to the Configure A Sound Power Level 
Measurementt section in Chapter 2, Installation and Configuration, for more information.

Save FFT—Click this button to save one or more of the current FFT 
spectra to a file. A selection box appears that lets you choose FFT spectra 
by clicking on the positions to be saved. Hold the <Shift> key while 
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clicking to select multiple positions. For more information on FFT file 
export format, refer to Appendix B, Program and Data Files.

Load FFT—Click this button to load FFT spectra from a file. A selection 
box appears that lets you choose FFT spectra by clicking on the positions 
to be loaded. Hold the <Shift> key while clicking to select multiple 
positions. For more information on FFT file format, refer to Appendix B, 
Program and Data Files.

Note FFT data files are saved and loaded independent of the sound power or sound 
pressure measurement file. The save and load buttons on this screen provide the only 
method of saving and loading FFT data files.

This FFT file contains position and frequency range information. When 
you load FFT, Sound Power Plus checks the frequency range of current 
measurement and the selected FFT file. You can only load FFT when both 
frequency ranges are the same.For example, you can only load the FFT of 
Position 1 in the file to Position 1 of the current measurement. Sound Power 
Plus does not load the FFT of the position, which is out of range of the 
current measurement.

Return to Oct Mode—Click this button to accept the data as displayed and 
exit the FFT measurement.

Discard and Return—Click this button to return the data to the state it was 
in the last time the Return to Octave Mode button was activated and exit 
the FFT measurement.

FFT Cursors
The FFT Sound Pressure Level Measurement routine provides two cursors 
that you can use to examine the FFT spectra. 

The cursors are initially located along the Y-axis of the FFT display. To 
access the cursor, click your mouse in the FFT display window. A cross hair 
will appear. Place this cross hair over the primary (yellow) cursor and use 
it to drag the cursor to the desired position on the FFT plot. The secondary 
(orange) cursor is accessed and moved in the same manner. Fine 
movements of the cursors can be made using the yellow left and right 
arrow controls at the upper right of the FFT display window.

The FFT cursors can be locked to any displayed FFT spectra. The dots on 
each cursor indicate which FFT spectra the cursor is currently locked on. 
The dot can be moved from spectrum to spectrum by using the green and 
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brown up and down arrow controls at the upper right of the FFT display 
window.

Sound Power Calculation
Figure  illustrates Sound Power Plus with the Sound Power Level 
Calculation data window active.

 

Figure 5-5.  Sound Power Level Calculation Data Window

This window is displayed when sound power level results are calculated. 
You can access this window by selecting Main Menu»Sound Power Level 
Measurement in the flowchart window, then clicking on the Sound Power 
Calculation button.

This window displays the currently configured measurement parameters 
that are used to make the sound power calculation. These parameters are 
configured in the sound power Measurement Configuration.
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This window displays a series of status indicators. When lit green, these 
indicators show the following calculations were made correctly:

• Ambient Surface Averaging—Valid ambient sound pressure level 
data resulted in calculation of valid surface average values.

• Source Surface Averaging—Valid source sound pressure level data 
resulted in calculation of valid surface average values.

• Ambient Correction—Ambient noise corrections resulted in valid 
corrected source sound pressure level data.

• Environmental Correction—Valid environmental correction data 
was applied to the corrected surface average sound pressure levels.

Meteorological Documentation
Temperature (C)—The temperature (in degrees Celsius) in the test 
chamber at the time of the test.

Relative Humidity (%)—The relative humidity (in percent) in the test 
chamber at the time of the test.

Barometric Pressure (kPa)—The barometric pressure (in kPa) at the time 
of the test.

Ambient Correction Configuration
Ambient Correction Method—Method (Position by Position or Surface 
Average) in which ambient noise corrections are made.

Ambient Correction Limit (dB)—The difference between the source and 
ambient sound pressure levels, below which either no ambient corrections 
are applied or a fixed correction is applied.

Option—Ambient correction method (No Correction Below Limit, Apply 
Correction Below Limit, or No Data if Below Limit) to apply if the 
difference between ambient and source exceeds the limit you set.

Measurement Option Configuration
Apply Environmental Correction—Indicates whether you applied the 
correction term based on temperature and barometric pressure.

Max Spread Flag—A maximum limit to the difference between the 
maximum and minimum sound pressure levels as a function of the number 
of measurement positions (Equal to the Number of Measurement Positions, 
or Equal to Half the Number of Measurement Positions).
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Express 1/3 Octave Sound Power Levels in bels—Calculates all 
1/3-octave band sound power level results in bels (1 bel = 10 dB).

Express Awtd/Lin Levels in bels—Calculates the Awtd and linear sound 
power level results in bels (1 bel = 10 dB).

OK—Click this button to accept the data as displayed in the current data 
table and exit the sound power calculation routine.

Review
Figure 5-6 shows Sound Power Plus with the Sound Power Level Report 
data window active.

 

Figure 5-6.  Sound Power Level Report Data Window



Chapter 5 Sound Power Level Measurement

Sound Power Plus Operator Manual 5-16 ni.com

Use this window to calculate the sound power and display the results. You 
can access this window by selecting Main Menu»Sound Power Level 
Measurement in the flowchart window, then clicking on the Review 
button.

Click the buttons at the bottom of the window to access the details of the 
sound power calculation. For more information about how the calculations 
are made, refer to Appendix A, Configuration Concepts, Protocols, and 
Calculations.

The results are displayed in the data table. For convenience, the 
A-weighted value is displayed in the leftmost column.

The results are displayed in a graphical form in the graphic window. 
If you entered reference spectrum, it can be displayed on the same graph.

Sound Power—Click this button to display the sound power test results 
and the associated flags. Ambient correction flags in this view are 
expressed by coloring the data affected by ambient interference as 
described in the legend.

Ambient SPL—Click this button to display the ambient sound pressure 
levels at each measurement position and the surface average ambient SPL.

Source SPL—Click this button to display the source sound pressure levels 
at each measurement position and the surface average source SPL.

Corrected SPL—Click this button to display the corrected ambient source 
sound pressure levels at each position and the surface average corrected 
ambient SPL.

Correction Flag—Click this button to display the ambient status flags 
for each position, the surface average, and any additional position status. 
Ambient correction flags in this view are expressed in terms of a condition 
code as described in the legend. These conditions codes are included with 
the exported data.

Corrections—Click this button to display the corrections applied 
to the test data to account for the effect of the test environment and 
meteorological conditions.

OK—Click this button to return to the Sound Power Main Menu.
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Save Measurement
Select File»Save Measurement to save the current test documentation and 
measurement data. A dialog box prompts you to enter the name of the file. 
The file is then saved in the Sound Power Plus native file format. Refer to 
Appendix B, Program and Data Files, for a discussion of file formats.
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6
Sound Pressure Level 
Measurement

The following sections describe how to measure operator and bystander 
sound pressure levels in accordance with the procedures of ISO 7779. 
Before you take a sound pressure level measurement, ensure that you have 
valid instrument and sound pressure level measurement configuration 
settings. Refer to the Configuring Your Instruments and Configure A 
Operator/Bystander Sound Pressure Level Measurement sections in 
Chapter 2, Installation and Configuration, for more information.

You can either load measurement data into Sound Power Plus from a file, 
or acquire new measurement data. To load measurement data from a file, 
select File»Load Measurement. A dialog box prompts you to enter the 
name of the file you want to load. The measurement file must match the 
current measurement configuration; otherwise, an error is returned. The 
data must be in Sound Power Plus native file format.

Note The current instrument, sound power level, and sound pressure level configuration 
files are displayed in the data window when the main program menu is active in the 
flowchart window.

To begin taking sound pressure level measurements, click the Sound 
Pressure Level Measurement button on the main flowchart menu. This 
launches the SPL Measurement flowchart window, from which you can 
make measurements.

Calibration
Click the Calibration button to calibrate and monitor the calibration of the 
system microphones. The sound pressure level calibration routine works 
like the sound power level calibration routine, except that the microphones 
that are displayed for calibration are the microphones you configured 
during the sound pressure level measurement setup. The calibration routine 
is described in detail in Chapter 4, Calibrate Your Microphones.



Chapter 6 Sound Pressure Level Measurement

Sound Power Plus Operator Manual 6-2 ni.com

Ambient SPL Measurement
Figure 6-1 illustrates Sound Power Plus with the Ambient SPL 
Measurement data window active.

 

Figure 6-1.  Ambient SPL Measurement Data Window

Use this window to measure and review ambient sound pressure level data. 
You can access this window by selecting Main Menu»Sound Pressure 
Level Measurement in the flowchart window, then clicking the 
Ambient SPL Measurement button.

Note The ambient sound pressure level measurement routine and controls work like the 
sound power level ambient sound pressure level measurement routine. The only difference 
is that ambient sound pressure levels are only acquired for the positions configured during 
the sound pressure level measurement configuration.



Chapter 6 Sound Pressure Level Measurement

© National Instruments Corporation 6-3 Sound Power Plus Operator Manual

Select—Select a check box to designate the position(s) you want to 
measure with the Meas Selected or One Apply to All buttons.

Pause/Proceed—This control determines whether a measurement pauses 
or proceeds after completing each measurement sequence. A pause in your 
measurement sequence is useful when you need to make changes to your 
setup, such as moving a microphone to a different position.

If any of the controls in a sequence are set to Pause, a prompt appears at the 
end of the sequence. If all of your controls are set to Proceed, Sound Power 
Plus starts the next measurement sequence immediately after the current 
sequence completes.

Overload Indicator—If the red indicator next to any position is lit, an 
overload occurred on the input of the DAQ board as the data was being 
acquired. If an overload occurs during an automated measurement 
sequence, the software attempts to re-measure the position before setting 
the indicator and proceeding. Data with overload indicators set might 
introduce errors in analysis.

OK Indicator—If the green indicator next to a position is lit, the data for 
that position was acquired without overload and there is valid data for all 
bands.

Data Table—Ambient sound pressure level data is displayed in the data 
table as it is obtained. The Awtd sound pressure level is displayed in the first 
column. This table has scroll bars that let you browse the entire data table. 
The yellow background of the unmeasured positions changes to green after 
the measurement is complete.

Measure All—Click this button to sample each measurement position, 
beginning with Measurement Sequence 1 and continuing through the last 
measurement sequence. This sequence pauses if the Paused/Proceed 
button is in the Paused mode.

Meas Selected—Click this button to sample each selected measurement 
position, starting with the first selected position and proceeding through all 
selected positions. This sequence pauses if the Paused/Proceed button is 
in the Paused mode.

Note Sound Power Plus can measure multiple positions at the same time according to 
Position Configuration of measurement. Refer to the Configure A Sound Power Level 
Measurement section in Chapter 2, Installation and Configuration, for more information.
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One Apply to All—Click this button if you want to make a single sound 
pressure level measurement at a selected position and copy the 
measurement result to all positions in the data table. If more than one 
position is selected, the routine measures the first position selected and 
clears all additional selections.

Measurement Time—If you want to temporarily override the 
measurement time you set for each microphone in the Position 
Configuration, enter the length of time (in seconds) you want the system to 
sample each position and select the Apply All check box. The 
measurement setup file in use is not changed.

Apply to All—Select this check box to apply the Measurement Time to 
all microphones during this measurement session.

All Measured—If the green All Measured indicator is lit, there is valid 
data for each configured position.

OK—Click this button to accept the data as displayed in the current data 
table and exit the ambient sound measurement routine.

Cancel—Click this button to return the data to the state it was in the last 
time you clicked on the OK button and exit the ambient sound 
measurement routine.
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Operator/Bystander Source SPL Measurement
Figure 6-2 illustrates Sound Power Plus with the Source Sound Pressure 
Measurement data window active.

 

Figure 6-2.  Source Sound Pressure Measurement Data Window

Use this window to measure operator and bystander position sound 
pressure levels. You can access this window by selecting Main Menu»
Sound Pressure Level Measurement in the flowchart window, then 
clicking the Source SPL Measurement button.

Note Many of the functions in this window are similar to those outlined for ambient sound 
pressure level measurement.
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If a purple bar appears over the position in the data table, the impulsive 
noise criteria was exceeded, as calculated in the following equation:

Select—Select a check box to designate the position(s) you want to 
measure with the Measure Selected button.

Pause/Proceed—This control determines whether a measurement pauses 
or proceeds after completing each measurement sequence. A pause in your 
measurement sequence is useful when you need to make changes to your 
setup, such as moving a microphone to a different position.

If any of the controls in a sequence are set to Pause, a prompt appears at the 
end of the sequence. If all of your controls are set to Proceed, Sound Power 
Plus starts the next measurement sequence immediately after the current 
sequence completes.

Overload Indicator—If the red indicator next to any position is lit, an 
overload occurred on the input of the DAQ board as the data was being 
acquired. If an overload occurs during an automated measurement 
sequence, the software attempts to re-measure the position before setting 
the indicator and proceeding. If an overload indicator is present at any 
position at the end of a measurement sequence, the overload indicator at the 
bottom of the data window lights red. Data with overload indicators set 
might introduce errors in analysis.

Data Table—Operator and bystander sound pressure level data is 
displayed in the data table as it is obtained. The Awtd sound pressure level 
is displayed in the first column. This table has scroll bars that let you 
browse the entire data table. The yellow background of the unmeasured 
positions changes to green after the measurement is complete.

Note The background color of the data table indicates whether the data in the data table is 
current data or if it was measured during an earlier visit to this menu. A yellow background 
indicates that the data was measured during an earlier visit, while a green background 
indicates that the data is from the current visit.

Measure All—Click this button to sample each measurement position, 
beginning with Sequence 1 and continuing through the last sequence. 
Measure All pauses if any of the controls in the current sequence are set 
to Pause.

LEqAI LEqA–( ) Impulsive Criteria Level>
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Meas Selected—Click this button to sample each selected measurement 
position, starting with the first position and proceeding through all 
measurement sequences until all selected positions are measured. Meas 
Selected pauses if any of the controls in the current sequence are set to 
Pause.

Note Sound Power Plus can measure multiple positions at the same time according to 
Position Configuration of measurement. Refer to the Configure A Sound Power Level 
Measurement section in Chapter 2, Installation and Configuration, for more information.

Measurement Time—If you want to temporarily override the 
measurement time you set for each microphone in the measurement setup, 
enter the length of time (in seconds) you want the system to sample each 
position and select the Apply All check box. The measurement 
configuration file in use is not changed.

Apply All—Select this check box to apply the Measurement Time to all 
microphones during this measurement session.

Overload—If an overload indicator is present at any position at the end of 
a measurement sequence, this indicator lights red. 

All Measured—If the green All Measured indicator is lit, there is valid 
data for each configured position.

OK—Click this button to accept the data as displayed in the current data 
table and exit the source sound pressure level measurement.

Cancel—Click this button to return the data to the state it was in the last 
time you clicked on the OK button and exit the source sound pressure level 
measurement.
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Sound Pressure Calculation
Figure 6-3 illustrates Sound Power Plus with the Sound Pressure Level 
Calculation data window active.

Figure 6-3.  Sound Pressure Level Calculation Data Window

This window is displayed when sound pressure level results are calculated. 
You can access this window by selecting Main Menu»Sound Pressure 
Level Measurement in the flowchart window, then clicking on the Sound 
Pressure Calculation button.

This window displays the currently configured measurement parameters 
that are used to make the sound pressure calculation. These parameters are 
configured in the sound pressure measurement configuration. For more 
information on each of the configuration parameters, refer to the sound 
pressure Measurement Configuration.
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This window displays a series of status indicators. When lit green, these 
indicators show the following calculations were made correctly:

• Ambient Averaging—Valid ambient sound pressure level data 
resulted in calculation of valid surface average values.

• Source Averaging—Valid source sound pressure level data resulted in 
calculation of valid surface average values.

• Ambient Correction—Ambient noise corrections resulted in valid 
corrected source sound pressure level data.

Ambient Correction Configuration
Ambient Correction Limit (dB)—The difference between the source 
sound pressure level and ambient sound pressure level, below which either 
no ambient corrections are applied or a fixed correction is applied.

Apply Correction Below Limit—Ambient correction method to apply if 
the difference between ambient and source exceeds the limit you set.

Position Configuration
Name—Lists selected operator and bystander positions.

X, Y, Z—Coordinates for each measurement position in meters, as defined 
in the Sound Pressure Level Measurement Position Configuration.

OK—Click this button to accept the data as displayed in the current data 
table.
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Sound Quality Analysis
Figure 6-4 illustrates Sound Power Plus with the Prominent Tone Listening 
Test data window active.

 

Figure 6-4.  Prominent Tone Listening Test Data Window

Use this window to document the status of prominent tone listening tests. 
You can access this window by selecting Main Menu»Sound Pressure 
Level Measurement in the flowchart window, then clicking on the Sound 
Quality Analysis button. For more information about sound quality 
analysis, refer to the Sound Quality Analysis Calculations section in 
Appendix A, Configuration Concepts, Protocols, and Calculations.

Note You must select the Go to FFT analysis to determine presence of Prominent 
Tone check box to access the prominent tone analysis routine.
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No Aural Examination or Prominent Tone Analysis—If you do not 
enter this routine during a test, the data file indicates that no aural 
(listening) test was conducted and that you did not use the FFT routine to 
determine whether prominent discrete tones were present. By default, this 
check box is selected.

Aural Examination indicates no Prominent Tones—This check box lets 
you document that an aural examination of the equipment under test was 
conducted and that no prominent discrete tones were audibly present.

Go to FFT Analysis to determine presence of Prominent Tone—This 
check box lets you document that FFT-based prominent tone analysis was 
used to determine whether prominent discrete tones were present. After 
you select this option, click OK to view the Prominent Tone Analysis 
window, which you can use to conduct prominent tone analysis on 
configured and measured operator/bystander positions. For more 
information, refer to the Prominent Tone Analysis section.

OK—Click this button to accept the data and exit the prominent tone 
listening test.

Cancel—Click this button to revert to the previously saved data and exit the 
prominent tone listening test.

Note If you attempt to change the state of the prominent tone listening test check boxes 
after an FFT prominent analysis has been conducted, the prominent tone table will be 
cleared. A dialog box appears for you to confirm that you want to clear the prominent tone 
table.
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Prominent Tone Analysis
Figure 6-5 illustrates Sound Power Plus with the Tone Analysis data 
window active.

 

Figure 6-5.  Tone Analysis Data Window

Use this window to conduct prominent tone analysis on configured and 
measured operator/bystander positions. You can access this window by 
selecting Main Menu»Sound Pressure Level Measurement»
Sound Quality Analysis in the flowchart window, then selecting the 
Go to FFT Analysis to determine presence of Prominent Tone check 
box.

The prominent tone analysis routine uses an FFT graphic display window 
with controls for selecting the microphone for analysis, zooming the FFT 
display, and controlling the prominent tone analysis bandwidth. The 
prominent tone analysis data window shows the status of the current tone 
under analysis and includes controls for logging the tones to a tone table.
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The prominent tone analysis routine acquires a time waveform sample of 
the sound pressure level of the selected microphone and then conducts a 
post-processing 12,800-line FFT analysis on the sample. This lets you view 
the FFT over the entire frequency range without having to acquire new 
samples.

Sound Power Plus conducts prominent tone analysis in accordance with the 
procedures outlined in ISO 7779 (1999), Annex D (Tone to Noise Ratio) 
and ANSI S1.13 (1995), Annex A (Tone to Noise and Prominence Ratio 
Method). Sound Power Plus can conduct analysis on up to two tones within 
a single critical band.

FFT Display and Cursors
The FFT display provides a graphical display for the 12,800-line FFT. 
A series of cursors are provided to select tones for analysis, bracket the 
tone, and indicate the critical and masking bands that surround the tone.

Tone Cursor—Use the Tone Cursor to select the center frequency of the 
primary or secondary tone you are analyzing. You can move the cursor by 
clicking the yellow cursor controls located below the FFT display. Click 
and drag the slider for course adjustment, and use the left and right arrows 
at the end of the control for fine adjustment.

Tone Bandwidth Cursors—Two blue cursors indicate the bandwidth of 
the energy contained in the selected tone for tone-to-noise ratio analysis. 
You can control these with the % of critical bandwidth slider bar located 
below the FFT display. When the Tone Selector control is in the Find 
Secondary Tone position, the primary tone bandwidth is highlighted in 
orange, and these blue cursors bracket the secondary tone. ISO 7779 
(1999), Annex D.5 requires that the maximum bandwidth of the primary 
tone not exceed 15% of the critical band centered around the tone center 
frequency. The blue Tone Bandwidth slider control is also limited to this 
15% value. If you want to select a primary tone bandwidth that exceeds 
15% of critical bandwidth, enter the percent of critical bandwidth desired 
into the input box of Tone Bandwidth control.

Critical Band Cursors—Two red cursors indicate the upper and lower 
band edges of the critical band centered on the tone frequency. These 
cursors cannot be controlled and are re-located when the analysis control is 
activated.

Masking Band Cursors—Two red cursors indicate the band edges of the 
masking energy used in the prominence ratio analysis. The masking bands 
extend from these cursor locations to the critical band cursor locations.
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ft (Hz)—Indicates the frequency of the current cursor location or the center 
frequency of the tone when you click Analysis.

Lt (dB)—Indicates the level (in decibels) at frequency ft of the current 
cursor location.

FFT Window Prominent Tone Analysis Controls
The FFT window contains a series of controls that facilitate prominent tone 
analysis. These controls let you configure an FFT measurement and select 
tones for analysis.

The program also supports averaging several microphones for prominent 
tone analysis. Double-click the positions to be included in the average prior 
to clicking Acquire.

Position—Select operator/bystander sound pressure level positions by 
clicking on the position. ISO 7779 recommends the prominent tone 
analysis be conducted at the operator position or the bystander position 
with the highest Awtd sound pressure level. In support of this 
recommendation, the positions will be listed in the following order:

1. Operator 1 (if configured)

2. Highest Awtd SPL Bystander Position (if configured)

3. 2nd Highest Awtd SPL Bystander Position (if configured)

4. 3rd Highest Awtd SPL Bystander Position (if configured)

5. 4th Highest Awtd SPL Bystander Position (if configured)

6. Operator 2 (if configured)

Averaging Time—This control lets you select the length of time 
(in seconds) the sound pressure level at the selected microphone will be 
sampled. An average FFT of this time sample signal will be performed.

Tone Selector—This switch lets you select whether the Tone Cursor and 
Tone Bandwidth Cursors are active for the selection of a primary or 
secondary tone. When Tone Selector is set to Find Primary Tone, use the 
cursors to select and bracket the primary tone you are analyzing. The 
critical bandwidth surrounding the time indicated with red cursors move as 
the center frequency of the primary tone changes. When the Tone Selector 
switch is set to Find Secondary Tone, Sound Power Plus freezes the 
critical bands surrounding the tone and the window zooming Span. The 
primary tone is highlighted in orange, and the Tone Cursors and Tone 
Bandwidth Cursors are activated for selection and bracketing of a 
secondary tone within the critical band that is centered on the primary tone.
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Acquire—Click this button to initiate the acquisition of a sample of the 
selected microphone for the time selected by the Averaging Time control. 
An average FFT is performed on the sample and displayed on the FFT 
display.

Center Frequency (Ft/Fs)—This control lets you select the center 
frequency of primary or secondary tone. When the Tone Selector switch is 
set to Find Primary Tone, use the control labeled ft to select the center 
frequency of a primary tone. The acceptable range for this control is 
0 to 16000 Hz. When the Tone Selector switch is set to Find Secondary 
Tone, use the control labeled fs to select the center frequency of the 
secondary tone. In this position, the acceptable range for this control is 
limited to upper and lower frequency of the critical band that contains the 
selected primary tone.

Level of Tone (Lt/Ls)—This indicator displays the energy level in the 
primary or secondary tone bandwidth. When the Tone Selector switch is 
set to Find Primary Tone, this indicator displays Lt, which is the energy 
contained in the selected bandwidth for the primary tone. When the Tone 
Selector switch is set to Find Secondary Tone, this indicator displays Ls, 
which is the energy contained within the selected bandwidth for the 
secondary tone.

Span (Hz)—Click this button to focus around the current cursor location 
and zoom into a selected frequency range. Use Span to select the frequency 
range (in Hz) indicated on the FFT display.

Tone Bandwidth—This control manages the bandwidth of the energy that 
will be included in the tone level during tone-to-noise ratio analysis. The 
blue cursors display the selected bandwidth, and the Tone Bandwidth 
indicator displays this bandwidth in terms of the percentage of the critical 
bandwidth for the critical band that is centered at the selected tone center 
frequency. Use the blue slider control to adjust the bandwidth between the 
minimum 1% and maximum 15% of critical bandwidth. Use the blue 
numerical bandwidth control to input a value greater than 15% but less than 
100% of the critical bandwidth if you want to override the limitations 
specified in ISO 7779.

Hide Cursors—Click this button to temporarily hide the prominent tone 
analysis cursors. This lets you view the FFT spectrum without interference 
from the cursors.

Analyze—Activate this control to conduct an analysis on the selected tone. 
Both tone-to-noise ratio and prominence ratio calculations will be 
performed simultaneously. Tone-to-noise ratio calculations are based on 
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the tone bandwidth that has been bracketed with the Tone Bandwidth 
controls. The results of the analysis are displayed in the Prominent Tone 
Analysis Results section of the data window. 

Note Tone-to-noise ratio analysis uses only the primary tone if Tone Selector is set to 
Find Primary Tone. If Tone Selector is set to Find Secondary Tone, the tone-to-noise 
ratio analysis includes the primary and secondary tones as defined with the Tone Cursor 
and Tone Bandwidth controls.

Save FFT—Click this button to save the current FFT measurement to a file.

Prominent Tone Analysis Results
The data window contains a series of indicators for displaying the results 
of the prominent tone analysis and a series of controls for logging tones to 
a prominent tone results table. The contents of the prominent tone results 
table are shown on the right side of the data window.

Position—The position under analysis

Tone Frequency—The center frequency of the primary tone in Hz

Tone to Noise Ratio (dB)—The calculated tone-to-noise ratio

Prominence Ratio (dB)—The calculated prominence ratio

Exceeded—Each tone analysis method (Tone-to-Noise Ratio/Prominence 
Ratio) has an Exceeded indicator. This indicator lights red if the analysis 
result exceeds the criteria level selected in sound quality analysis options.

Log—Each tone analysis method (Tone-to-Noise Ratio/Prominence Ratio) 
has a button that allows the analysis results to be logged to the prominent 
tone table. Click this button to write the results of the selected analysis 
method to the prominent tone table.

Band Levels (dB)—This table provides information about the levels in 
each of the bands used for prominent tone analysis. 

• Tone—Level in bandwidth bracketed by tone bandwidth cursors for 
tone-to-noise ratio analysis.

• Critical—Level in the critical band surrounding the selected tone, 
exclusive of the energy bracketed by the tone bandwidth cursors.
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• Lower Mask—Level in the lower masking band for prominence ratio 
analysis.

• Upper Mask—Level in the upper masking band for prominence ratio 
analysis.

Secondary Tone—This table displays the information of the secondary 
tone when you select that option during prominent tone analysis. 

• Frequency—This indicator displays the center frequency of the 
secondary tone in Hz.

• Level (dB)—This indicator displays the sound pressure level within 
the secondary tone bandwidth.

Prominent Tone Table
To the right of the prominent tone analysis data window is the prominent 
tone table, where the logged results are displayed.

Delete Selected—Lets you highlight a logged tone and delete it.

Clear Table—Lets you delete all logged tones.

OK—Click this button to accept the values and return to the main SPL 
Measurement flowchart.

Cancel—Click this button to ignore your changes and return to the main 
SPL Measurement flowchart.

Note Use the Save FFT feature included in the prominent tone analysis routine to save the 
high resolution FFT results to a file. If you are using the demo version of Sound Power 
Plus, you can view these results files by renaming them to Operator1.txt and moving 
them to the Sound Power Plus Demo/Bin directory. This feature allows you to 
re-analyze FFT spectra from prominent tones at a later date. Contact National Instruments 
for more information on the Sound Power Plus demo version.
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Review
Figure 6-6 illustrates Sound Power Plus with the Sound Pressure Level 
Report data window active.

 

Figure 6-6.  Sound Pressure Level Report Data Window

Use this window to display the results of the sound pressure level 
measurement and calculations. You can access this window by selecting 
Main Menu»Sound Pressure Level Measurement in the flowchart 
window, then clicking on the Review button.

Click the buttons at the bottom of the window to access the details of the 
sound power calculation. For more information about how the calculations 
are made, refer to Appendix A, Configuration Concepts, Protocols, and 
Calculations.
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The results are displayed in the data table. For convenience, the A-weighted 
value is displayed in the leftmost column.

The results are displayed in a graphical form in the graphic window. If you 
entered reference spectrum, it can be displayed on the same graph.

Corrected SPL—Click this button to display the corrected source sound 
pressure levels at each position and the surface average corrected source 
sound pressure level. Ambient correction flags are displayed as colored 
indicators on the corrected sound pressure level data in accordance with the 
legend on the screen.

Ambient SPL—Click this button to display the ambient sound pressure 
levels at each measurement position and the surface average ambient SPL.

Source SPL—Click this button to display the source sound pressure levels 
at each measurement position and the surface average source SPL.

Correction Flag—Click this button to display the ambient status flags for 
each position, the surface average, and any additional position status. 
Ambient correction flags in this view are expressed in terms of a condition 
code as described in the legend. These conditions codes are included with 
the exported data.

Tone Analysis—Click this button to display the prominent tone test 
results.

OK—Click this button to return to the Sound Pressure main menu.
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7
Exporting Data

Sound Power Plus allows you to export data into text files or pre-formatted 
Microsoft Excel workbook template files. Figure 7-1 illustrates the Data 
Export window.

Figure 7-1.  Data Export Window

• Export Data to Excel—Click this button to export data to Microsoft 
Excel 97 or its higher version. 

• Export Data to Text—Click this button to export data to text file. 

Tip You can also access this window by selecting Main Menu»Export Data in the flow 
chart window.

Save to Excel File
Selecting Export to Excel disables the option controls for Export Data to 
Text. Clicking Export brings up another dialog window for exporting data 
into pre-formatted Microsoft Excel workbook template files. These 
workbook template files contain a series of worksheets for each section of 
the test information. You can also add additional worksheets to your 
template workbook files. You can preconfigure and pre-link these 
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additional worksheets to your export worksheets, providing an efficient 
method for setting up custom data analysis templates. See Appendix B, 
Program and Data Files, for more information on the structure of 
workbook template files.

Note The Export to Excel feature of Sound Power Plus exports all SPL and SPL test 
documentation and test data associated with the test into the first 11 worksheets of an Excel 
workbook. To export partial data from the project, use the Export Data feature on the 
Sound Power, Source Sound Pressure Level measurement window (see the Exporting Data 
section in Chapter 5, Sound Power Level Measurement) or the Export to Text feature.

When you click the Export Data button, a file dialog box prompts you to 
choose a template file as the export destination. You can select any Excel 
workbook that is structured as described in Appendix B, Program and 
Data Files.

Note Sound Power Plus includes an example workbook template file called Report 
Template.xls. This workbook template file contains all necessary worksheets for Sound 
Power Plus export data and contains several user worksheets that create certificate-like test 
reports for sound power and sound pressure measurement data. You can use this workbook 
template file to create other custom template files.

1. Select a template file for the export and click Open.

A file dialog box prompts you to enter or confirm a default file name 
for the exported data file. By default, the routine suggests a file name 
of Test Name_Operating Mode, where Test Name and 
Operating Mode are derived from the test documentation. Learn 
more about configuring your test documentation in Chapter 3, 
Documenting Your Test, for information on configuring your test 
documentation. You can accept this name or enter a new file name.

2. Click Save to Export. 

A dialog box informs you of the progress of the export progress. 
A check box option lets you leave Excel open after the data is exported.
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Save to Text file
The Save to Text file allows you to select any or all of the test 
documentation or test data for export. When you choose this option, the 
controls for Save to Text are enabled. Select the items you want to export 
by highlighting them on the left side of the dialog box, and move them 
into the export list on the right side of the dialog box by pressing the 
<arrow> control. You can select all documentation and data using the 
All control. Remove items from the export list by highlighting them and 
pressing Del.

Data—This control contains all data items that can be exported.

Select—Press the arrow key to place the selected items in Data control into 
the Export Data list. 

All—Click this button to select all data items and add them to the Export 
Data list.

Del—Press Del to deselect a data item. You can only deselect one data item 
at a time.

Export Data—Contains a list of all data items selected for export.

Text File Name—This file dialog control contains the name of the text file 
you have selected as your destination. You can specify a new file name or 
locate an existing file with the Browse function. The default file name is 
Test Number_Operating Mode.txt and the default file path is 
the/Data/Measurement directory.

Delimiter—Use this control to specify a delimiter for the exported file. 
<Tab> is the default delimiter and works well for text data that you are 
exporting into spreadsheet or database files. You may also select Other in 
the Delimiter control to activate the Other control, allowing you to specify 
a custom delimiter.

Other—This option appears only when you select Other in the Delimiter 
list box. This control allows you to use any character as a delimiter in an 
exported-text file.

Note Be sure to choose delimiter character(s) that do not appear in any of the data fields 
you are exporting.
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Export—Click Export to export the data contained in the Export Data 
window. If the saved file already exists, Sound Power Plus prompts you for 
approval before executing the export. If you click OK, the data in the 
existing file will be replaced. When the data export is complete, the Export 
data window is closed.

Cancel—Click Cancel to cancel the export process without exporting any 
data. 
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8
Configure the Reference 
Spectrum

The reference spectrum feature allows the following types of spectra to be 
held in the system for comparison with measurement results:

• Sound Power Level—A sound power reference spectrum that is 
displayed in the graphic window with the current sound power 
measurement result.

• SPL for Sound Power Level—A sound pressure level spectrum that is 
displayed in the graphic window with the sound pressure level 
measurements made during a sound power level measurement.

• SPL at Operator Position—A sound pressure level spectrum that is 
displayed in the graphic window with the sound pressure level 
measurements made during the operator/bystander sound pressure 
level measurement.

• Free Running SPL—A reference spectrum that is displayed in the 
graphic window when the RTA is in free-running mode.

• Source FFT—An FFT spectrum that is displayed in the graphic 
window during the source sound pressure level FFT measurement.

Reference spectra are displayed on the graphic window along with the 
current measurement or results spectrum. 1/3-octave reference spectra are 
displayed as a series of yellow dots, and reference FFT spectra are 
displayed as dark green lines.

Enter reference spectra the system using the following methods:

• The sound power level, operator/bystander sound pressure level 
graphic results, and RTA windows have controls that let you store 
the current spectrum as a reference spectrum. 

• Reference spectra can be saved to a named file and loaded into the 
reference spectrum using the main menu bar.



Chapter 8 Configure the Reference Spectrum

Sound Power Plus Operator Manual 8-2 ni.com

Follow these steps to place a spectrum from one of the measured positions 
into the Reference Spectrum:

1. Select the position you want to include in the Reference Spectrum 
by clicking the check box for that position.

2. Move the switch on the RTA to the Measured position.

3. Click the Save Spectrum button on the RTA.

Reference spectra are constantly displayed in the graphic window. To turn 
off a reference spectrum, select Reference»Edit Spectrum, then click the 
Clear button in the Reference Spectrum Edit for Instrument Configuration 
data window to change all frequency bands to NaN (Not a Number).

Reference Spectrum Configuration
You can either load reference spectrum information into Sound Power Plus 
from a file, or enter new reference spectrum data. To load a spectrum into 
the selected reference, select Reference»Load Spectrum. A dialog box 
prompts you to enter the name of the file you want to load. The spectrum 
files must be in Sound Power Plus native file format.

To load the default reference spectrum data, select Reference»
Load Spectrum»Default, then select a reference spectrum 
(Sound Power Level, SPL for Sound Power Level, SPL at Operator 
Position, Free Running SPL, or Source FFT). Select Reference»

Load Spectrum»Default»All if you want to load the default files for all 
reference spectra.

To enter or clear the reference spectrum data, select Reference»
Edit Spectrum.
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Figure 8-1 illustrates Sound Power Plus with the Reference Spectrum Edit 
for Instrument Configuration data window active.

 

Figure 8-1.  Reference Spectrum Edit for Instrument Configuration Data Window

Use this window to edit or clear the sound power and sound pressure 
reference spectra supported by the software. You can also use this window 
to view, load, and enable the FFT reference spectrum. You can access this 
window by selecting Reference»Edit Spectrum from the main menu.

Reference Spectra Table—Lists the current values for the sound power 
and sound pressure level reference spectra supported by the software. You 
can edit values in this table by selecting the cell and entering a new value.

Clear—Clears the values in this reference spectrum. When you click this 
button, all cells are set to NaN (Not a Number) and no reference spectrum 
is displayed.
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Load FFT—Click this button to load an FFT spectrum from a saved file. 
A prompt appears asking you to choose the file.

Enable—Select this check box to enable the FFT reference spectrum. 

Note The FFT reference spectrum cannot be manually edited.

OK—Click this button to accept the values you entered and exit the 
reference spectrum configuration.

Cancel—Click this button to cancel all entries and exit the reference 
spectrum configuration.
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A
Configuration Concepts, 
Protocols, and Calculations

Instrument and Measurement Configuration Concepts
Sound Power Plus instrument and measurement configuration routines are 
based on the concepts explained in the following sections.

Instrument Configuration
During instrument configuration, you set up your DAQ boards with one or 
more measurement channels each. Sound Power Plus supports the NI 4551 
and NI 4552 boards.

Each DAQ channel can have a multiplexer with multiple microphone 
inputs. Several common microphone multiplexers are currently supported 
as listed in Appendix C, Supported Drivers.

During instrument configuration, you can configure the number of 
microphones on the instrumentation system.

Measurement Configuration
During the measurement configuration, you define a number of 
measurement positions, then assign one of the configured microphones 
to each position. Using this concept, the number of measurement 
positions is independent of the number of microphones available on 
the measurement system.
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Table A-1 illustrates an example of how microphones might be assigned.

Table A-1.  Microphone Assignment Logic

Position 
Number

Microphone 
Number

Multiplexer 
Number

Multiplexer 
Channel 
Number

Board 
Number

Board 
Channel 
Number

Position 1 Microphone 1 Mux 1 Mux Channel 1 Board 1 Channel 1

Position 2 Microphone 2 Mux 1 Mux Channel 2 Board 1 Channel 1

… … … … … …

Position 10 Microphone 10 Mux 1 Mux Channel 10 Board 1 Channel 1

Position 11 Microphone 11 Mux 2 Mux Channel 1 Board 1 Channel 2

Position 12 Microphone 12 Mux 2 Mux Channel 2 Board 1 Channel 2

… … … … … …

Position 19 Microphone 19 Mux 2 Mux Channel 9 Board 1 Channel 2

Position 20 Microphone 20 Mux 2 Mux Channel 10 Board 1 Channel 2
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Figure A-1 illustrates an example system.

Figure A-1.  Example System

A single microphone can be assigned to one or more measurement 
positions. This allows multi-position sound power measurements to be 
made with instrumentation systems containing fewer microphones than 
measurement positions. For example, you could use one microphone to 
make a 10-position sound power measurement. Or, you could use a 
ten-microphone grid to make a 20-position sound power measurement. 
The Paused/Proceed option on the Measurement Setup menu and 
Measure Selected Position(s) option on the sound pressure level 
measurement menus facilitate the use of this functionality.

The software supports frequency response corrections for each 
measurement channel (microphone). These frequency response 
corrections are associated with each microphone measurement 
channel that has been configured for the system.
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Sound Power Ambient Correction Calculation Logic
The following tables describe the steps and calculations Sound Power Plus 
uses to calculate the ambient correction.

Position-by-Position Corrections
Table A-2 describes how ambient corrections are applied on a 
position-by-position basis, as described in ISO 7779-1988, section 6.7.3.

Table A-2.  Position-by-Position Ambient Corrections

Action Calculations

Correct source SPL at 
each position using 
ambient SPL at each 
position

Case: SourceSPL(f,n) – AmbientSPL(f,n) ≥ Correction Limit

CorrectedSPL(f,n) = 10 * log (10SourceSPL(f,n)/10 – 10AmbientSPL(f,n)/10)

Case: SourceSPL(f,n) – Ambient SPL(f,n) < Correction Limit

If Correct Below Limit = True

CorrectedSPL(f,n) = SPL(f,n) + 10 * log (1 – 10–CorrectLimit/10)

If No Data Below Limit = True

CorrectedSPL(f,n) = 0

If Correct Below Limit = False AND No Data Below Limit = False

CorrectedSPL(f,n) = SourceSPL(f,n)

Set ambient status flags 
for each position

Case: SourceSPL(f,n) – AmbientSPL(f,n) ≥ Correction Limit

AmbientStatusFlag(f,n) = 0

Case: Correction Limit > SourceSPL(f,n) – AmbientSPL(f,n) > 0

AmbientStatusFlag(f,n) = 1

Case: SourceSPL(f,n) – AmbientSPL(f,n) ≤ 0

AmbientStatusFlag(f,n) = 2

Surface average source, 
ambient, and corrected 
source sound pressure 
levels

SurfaceAvgSPL(f) = 10 * log (1 / TotSurfaceArea *

 * 10 SPL(f,n) / 10)

Do this calculation for SourceSPL, AmbientSPL, and 
CorrectedSourceSPL for all frequency bands.

SurfaceArea n( )
i=1

i=n

∑
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Set surface average 
ambient status flags

Case: SurfaceAvgSourceSPL(f) – SurfaceAvgAmbientSPL(f) ≥ 
Correction Limit

SurfaceAvgAmbientStatusFlag(f) = 0

Case: Correction Limit > SurfaceAvgSourceSPL(f) – 
SurfaceAvgAmbientSPL(f) < 0

SurfaceAvgAmbientStatusFlag(f) = 1

Case: SurfaceAvgSource(f) – SurfaceAvgAmbient(f) ≤ 0

SurfaceAvgAmbientStatusFlag(f) = 2

Calculate sound power Case: Apply Meteorological Correction = True

SoundPower(f) = SurfaceAvgCorrectedSoundPressure(f) + 10 * 
log(TotSurfaceArea) – 10 *log[(314.15 / (1013.25 + 
Temperature))0.5 * (BarometricPressure / 1013.25)]

Case: Apply Meteorological Correction = False

SoundPower(f) = SurfaceAvgCorrectedSoundPressure(f) + 10 * 
log(TotalSurfaceArea)

Where
n = measurement position Barometric Pressure in millibars
f = 1/3-octave band center frequency Temperature in °C
Total Surface Area in square meters

Table A-2.  Position-by-Position Ambient Corrections (Continued)

Action Calculations
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Surface Average Corrections
Table A-3 describes how ambient corrections are applied based on surface 
average, as described in ISO 3744-1994, section 8.3.

Table A-3.  Surface Average Ambient Corrections

Action Calculations

Set ambient status flags 
for each position

Case: SourceSPL(f,n) – AmbientSPL(f,n) ≥ Correction Limit

AmbientStatusFlag(f,n) = 0

Case: Correction Limit > SourceSPL(f,n) – AmbientSPL(f,n) > 0

AmbientStatusFlag(f,n) = 1

Case: SourceSPL(f,n) – AmbientSPL(f,n) ≤ 0

AmbientStatusFlag(f,n) = 2

Surface average source 
and ambient sound 
pressure levels

SurfaceAvgSPL(f) = 10 * log (1 / TotSurfaceArea *

 * 10SPL(f,n) / 10)

Do this calculation for SourceSPL and AmbientSPL for all frequency 
bands.

Correct surface average 
source sound pressure 
level using surface 
ambient sound pressure 
level

Case: SurfaceAvgSourceSPL(f) – SurfaceAvgAmbientSPL(f) ≥ 
Correction Limit

CorrectedSurfaceAvgSourceSPL(f) – 10 * log 
(10SurfaceAvgSourceSPL(f)/10 – 10SurfaceAvgAmbientSPL(f)/10)

Case: SurfaceAvgSourceSPL(f) – SurfaceAvgAmbient SPL(f) < 
Correction Limit

If Correct Below Limit = True

CorrectedSurfaceAvgSourceSPL(f) = SurfaceAvgSourceSPL(f) + 
10log(1-10(-CorrectionLimit/10))

If No Data Below Limit = True

CorrectedSurfaceAvgSPL(f) = 0

If Correct Below Limit = False AND No Data Below Limit = False

CorrectedSurfaceAvgSPL(f) = SurfaceAvgSourceSPL(f)

SurfaceArea n( )
i=1

i=n

∑
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Set surface average 
ambient status flags

Case: SurfaceAvgSourceSPL(f) – SurfaceAvgAmbientSPL(f) ≥ 
Correction Limit

SurfaceAvgAmbientStatusFlag(f) = 0

Case: Correction Limit > SurfaceAvgSourceSPL(f) – 
SurfaceAvgAmbientSPL(f) < 0

SurfaceAvgAmbientStatusFlag(f) = 1

Case: SurfaceAvgSource(f)-SurfaceAvgAmbient(f) ≤ 0

SurfaceAvgAmbientStatusFlag(f) = 2

Calculate sound power Case: Apply Meteorological Correction = True

SoundPower(f) = SurfaceAvgCorrectedSoundPressure(f) + 10 * 
log(TotSurfaceArea) – 10 *log[(314.15 / (273.15+Temperature))0.5 

* (BarometricPressure / 1013.25)]

Case: Apply Meteorological Correction = False

SoundPower(f) = SurfaceAvgCorrectedSoundPressure(f) + 10 * 
log(TotalSurfaceArea)

Where
n = measurement position Barometric Pressure in millibars
f = 1/3-octave band center frequency Temperature in °C
Total Surface Area in square meters

Table A-3.  Surface Average Ambient Corrections (Continued)

Action Calculations
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Sound Quality Analysis Calculations
Sound Power Plus implements the following two sound quality analysis 
routines:

• Impulsive Noise Analysis—An impulsive noise analysis routine that 
follows the procedures defined in ISO 7779, Annex E, is integrated 
into the operator/bystander source sound pressure level measurement 
routine, providing “on-the-fly” impulsiveness analysis of sound 
pressure at each position. This routine utilizes the ability of the 
instrument to calculate both LA and LAI simultaneously. Indicators on 
the source sound pressure level data window indicate when LAI 
exceeds LA by an amount defined in the sound quality analysis options 
for impulsive noise criteria level. The state of the impulsive noise 
indicator for each position is stored in the program data file and is 
exported to Excel for use in reporting.

• Prominent Tone Analysis—Sound Power Plus supports prominent 
tone analysis by two methods:

– Tone to Noise Ratio—As defined in ISO 7779, Annex D. 

– Prominence Ratio Analysis—As referenced in ISO 7779, 
Annex D, and ANSI S1.13. See A Procedure for Determining 
the Prominence Ratio of Discrete Tones in Noise Emissions 
by Nobile and Bienvenue for detailed information on the logic 
employed by the prominence ratio routine.

A prominent tone listening test provides for documentation of listening 
and/or FFT analysis activities conducted to determine the presence of 
prominent discrete tones. Prominent tones are detected when the tone 
band energy exceeds the masking band energy by a criteria level that is 
established in the Sound Quality Analysis in the sound pressure level 
measurement configuration. Prominent tones detected by either or both 
methods may be logged to a prominent tone table which is stored with 
the test data file and exported into Excel for use in reporting.
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Prominent Tone Logic and Calculations
Figure A-2 and Table A-4 describe the calculations performed at each step 
in the prominent tone analysis routine.

Figure A-2.  Prominent Tone Analysis Logic
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Table A-4.  Prominent Tone Logic and Calculations

Action Calculations

Bracket possible tone 
(Tone bandwidth control)

Tone Cursor Position = fp = ft; primary tone center frequency
Upper Cursor Position = fpu; primary tone upper frequency limit
Lower Cursor Position = fpl; primary tone lower frequency limit
Primary tone bandwidth = ∆fp=fpu-fpl 

Calculate critical and 
masking bands for 
possible tone under 
analysis

∆fc = 25 + 75 * (1 + 1.4(ft/1000)2) 0.69; critical bandwidth
fcl= -∆fc / 2 + sqrt (∆fc 2 + 4 * ft 2) / 2; critical band lower freq limit
fcu = fcl +∆fc     critical band upper freq limit
fmll = fcl 2 / fcu      masking noise, low band, lower freq limit
fmlu = fcl         masking noise, low band, upper freq limit
fmul = fcu         masking noise, upper band, low freq limit
fmuu = fcu 2 / fcl   masking noise, upper band, upper freq limit

Bracket possible 
secondary tone (optional)

Tone Cursor Position = fs; secondary tone center frequency
Upper Cursor Position = fsu; secondary tone upper frequency limit
Lower Cursor Position = fsl; secondary tone lower frequency limit
Secondary tone bandwidth = ∆fs=fsu-fsl 

Calculate energy in tone 
and critical bands

W’p = Energy sum between fpu and fpl

W’s = Energy sum between fsu and fsl

Wc = Energy sum between fcl and fcu

Wml = Energy sum between fmll and fmlu

Wmu = Energy sum between fmul and fmuu

Wi = Σ 10 (SPLi/10)

Calculate Prominence 
Ratio

PR = 10log (Wc / ((Wml + Wmu) / 2))

Calculate Energy of 
Tones and Noise

Case 1: No secondary tone allocated
Wn = (Wc-W’p) * [∆fc / (∆fc - ∆fp)]
Wt = W’p – W’n *∆fp / ∆fc

Case 2: Secondary tone allocated
Wn = (Wc-W’p - W’s) * [∆fc / (∆fc - ∆fp - ∆fs)]
fd = 21 * 10^ [1.2 | log (ft/212) |1.8]

    If [fp-fs] ≤ fd

        Wt = W’p + W’s - Wn * (∆fp + ∆fs)/ ∆fc

    If [fp-fs] > fd

        Wt = W’p – W’n *∆fp / ∆fc
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Calculate Tone to Noise 
Ratio

TNR = 10 log (Wt / Wn)

Test tone ratios against 
criteria levels

Set Tone-to-Noise and/or Prominence Ratio indicators

Table A-4.  Prominent Tone Logic and Calculations (Continued)

Action Calculations
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Operator/Bystander Calculations
Operator/bystander ambient noise corrections follow the same general 
logic as described for sound power ambient noise corrections. The 
following logic is unique to the sound pressure routine:

• Ambient corrections are applied on a position-by-position basis for 
each individual position.

• There is no No Data if below Limit option.

Ambient status flags are applied as described in the sound power routine.

Operator Average Sound Pressure Level Calculation
If Operator 1 and Operator 2 positions are active, the program calculates an 
operator average sound pressure level by energy averaging the Operator 1 
and Operator 2 sound pressure level data. If only Operator 1 or Operator 2 
positions are active, the operator average sound pressure level will equal 
the active operator position sound pressure level.

Operator average ambient status flags are set by comparing the average 
operator source and ambient sound pressure levels.

Bystander Average Sound Pressure Level Calculation
The software calculates a bystander average sound pressure level for all 
bystander positions by energy averaging the sound pressure level data for 
all bystander positions that are active.

Bystander average ambient status flags are set by comparing the average 
bystander source and ambient source pressure levels. If only one bystander 
position is active, the bystander average source pressure level equals the 
corrected source pressure level for the selected bystander position. If no 
bystander position is active, no bystander average source pressure level 
is calculated.

Sound Pressure Level Measurement Precision and 
Rounding Issues

All sound pressure level measurements made by the board are rounded to 
the nearest 0.1 dB before the levels are entered into the program database. 
All intermediate calculations are double-precision calculations that are 
conducted on this rounded data, with no intermediate rounding steps.
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B
Program and Data Files

Sound Power Plus creates and uses several types of files, as defined in 
Table B-1.

Table B-1.  File Types Used by Sound Power Plus

Type of File Extension Default Location Default File Name

Measurement .Mea Sound Power\Data\ 

Measurement

test name_ 
operating mode

Sound Power Data .PWL Sound Power\Data\ 

Measurement

test name_ 
operating mode

Sound Pressure Data .SPL Sound Power\Data\ 

Measurement

test name_ 
operating mode

Instrument 
Configuration

.InC Sound Power\Data\Config Global_Instrument 
Configuration_ 
Default

PWL Measurement 
Configuration

.PWC Sound Power\Data\Config Global_Sound Power 
Level_Default

SPL Measurement 
Configuration

.SPC Sound Power\Data\Config Global_Sound 
Pressure 
Level_Default

PWL Reference 
Spectrum

.ReP Sound Power\Data\Spectra Ref_Sound Power 
Level_Default

SPL for PWL 
Reference Spectrum

.ReL Sound Power\Data\Spectra Ref_SPL for Sound 
Power Level_Default

Operator/ Bystander 
SPL Reference 
Spectrum

.ReL Sound Power\Data\Spectra Ref_SPL at Operator 
Positions_Default

Free Running SPL 
Reference Spectrum

.ReL Sound Power\Data\Spectra Ref_Sound Pressure 
Level_Default
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Sound Power Plus test data is stored in three files. One file contains the 
sound power measurement data. A second file contains the sound pressure 
level measurement data. The .Mea file is used to link these files into a 
single test file. When loading or saving data in Sound Power Plus, you 
reference the .Mea file. When copying data files to another directory or 
computer, you must copy all three files. 

All files other than .xls, .txt, and .ini files are saved in native file 
format for Sound Power Plus. These files are created or read from within 
Sound Power Plus. They cannot be edited by a text editor or Microsoft 
Excel. This file format is used for test data files, instrument and 
measurement configuration files, and reference spectrum files.

Microphone 
Sensitivity

.xls Sound Power\Data\ 

Microphone

Microphone 
Sensitivity 
Template

Data Export .xls Sound Power\Data\ 

Measurement

test name_operating 
mode

FFT Reference 
Spectrum

.txt Sound Power\Data\ 
Measurement

Ref_FFT_Default

FFT Data .txt Sound Power\Data\ 

Measurement

Not applicable

Excel Export 
Template

.xls Sound Power\Data\ 

Template

Report Template

Multiplexer Data .xls Sound 

Power\Data\Multiplexer 

Drivers

multiplexer.ini

Text Export Files .txt Sound 
Power\Data\Measurement

Test name_operating 
mode

Multiplexer Data .ini Sound 
Power\Data\Multiplexer 
Drivers

multiplexer.ini

Text Information .ini Sound Power\Data Test 
information.ini

Table B-1.  File Types Used by Sound Power Plus (Continued)

Type of File Extension Default Location Default File Name
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.xls files—Microsoft Excel file format used for data export files and 
microphone sensitivity files. 

• The Export Data to Excel function in Sound Power Plus main menu 
writes, but does not read, .xls files.

• The Export Data to Excel function in the Source SPL Measurement 
menu reads and writes .xls files.

• Sound Power Plus reads, but does not write, microphone sensitivity 
files saved in the .xls format.

.ini files—Text files containing Sound Power Plus data. 

All Sound Power Plus multiplexer information is located in a file named 
Sound Power\Data\Multiplexer Drivers\Multiplexers.ini. 
This text file includes all of the necessary multiplexer information required 
for using a multiplexer driver with Sound Power Plus.

You can add your own multiplexer files to Multiplexers.ini. 
Sound Power Plus can incorporate the new multiplexer files into the list 
of configurable multiplexers available in your system configuration.

Sound Power Plus also dynamically calls the multiplexer driver 
designated in Multiplexers.ini when operating a multiplexer. Refer 
to Appendix C, Supported Drivers, for more information on drivers.

All Sound Power Plus test information options for test documentation is 
located in a file named Sound Power\Data\Test Information.ini. 
This file includes several source types and operation modes. Sound Power 
Plus uses this test information when you set up your source information for 
your test documentation. You can add or remove items from this file if they 
do not fit your application.

Data Export Files
Sound Power Plus supports the export of test data into Excel workbooks. 
Data is exported onto a series of worksheets within a workbook template. 
Data is organized onto worksheets to facilitate review and formula 
referencing.

Workbook Templates
Sound Power Plus can export all test documentation, measurement, and 
configuration data into an Excel workbook. The export process is explained 
in Chapter 7, Exporting Data. Data is exported into workbook template 
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files that you can customize. The standard format for an Excel workbook 
template is an Excel file with 11 specific worksheets and additional 
customizable analysis worksheets. The workbook uses the following 
format:

• Worksheet 1 (Test Documentation)—All data from the four Test 
Documentation windows.

• Worksheet 2 (Measurement Setup)—All data from the sound power 
and sound pressure level measurement configuration screens.

• Worksheet 3 (Microphone Data)—All data associated with the 
sensitivity, calibration parameters, and frequency response corrections 
for the microphones that were configured for this test.

• Worksheet 4 (PWL Ambient SPL)—Ambient sound pressure level 
data obtained during the sound power level measurement routine.

• Worksheet 5 (PWL Source SPL)—Source sound pressure level data 
obtained during the sound power level measurement routine.

• Worksheet 6 (PWL Corrected Source SPL)—The corrected sound 
pressure level data and ambient condition flags calculated during the 
sound power level measurement routine.

• Worksheet 7 (Sound Power)—Sound power levels calculated during 
the sound power level measurement routine.

• Worksheet 8 (SPL Ambient)—Ambient sound pressure level data 
obtained during the operator/bystander sound pressure level 
measurement routine.

• Worksheet 9 (SPL Source)—Source sound pressure level data 
obtained during the operator/bystander sound pressure level 
measurement routine.

• Worksheet 10 (Operator/Bystander SPL)—The corrected sound 
pressure level data and ambient conditions flags calculated during the 
operator/bystander sound pressure level measurement routine.

• Worksheet 11 (Prominent Tones)—Prominent tones recorded to the 
prominent tone table during sound quality analysis in the 
operator/bystander sound pressure level routine.

• Worksheet 12-n (User Worksheets)—You can establish export 
template files that contain pre-designed analysis worksheets, graphs, 
and reports. Sound Power Plus lets you designate the name of the 
template file into which the test data is exported.
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The Report Template workbook provided with Sound Power Plus creates 
three custom worksheets that provide certificate-based reports of sound 
power and sound pressure test data. Use this workbook as an example to 
create custom analysis template files of your own.

Note Sound Power Plus exports data into Excel workbooks that are configured consistent 
with the master template file format. The first 11 worksheets of the Excel template file must 
be named as shown in the template file. Any custom entries on the first 11 worksheets will 
be overwritten when the data is exported. User worksheets must be named with names 
other than those used for the 11 export worksheets. Data on user worksheets is not changed 
during data export.

Microphone Sensitivity Files
Data on microphone sensitivity, calibration parameters, and frequency 
response is stored in this Excel worksheet.

Worksheet Contents
You can import microphone parameters into Sound Power Plus from this 
Excel worksheet. In this worksheet, you can give each microphone a name 
and serial number. You can also track and document microphone 
sensitivity, normal calibration offsets, and frequency response. You can 
view, add, and edit microphone parameters in the Microphone 
Sensitivity Template.xls file.

(Microphone) Name—A common name by which the microphone is 
referred to in Sound Power Plus (such as Microphone 1, Mic A, and so on).

Serial Number—A serial number (often as assigned by the manufacturer) 
that uniquely identifies the microphone.

Nominal Sensitivity—The nominal sensitivity (as assigned by the 
manufacturer) of the microphone (in mV/Pa). The nominal sensitivity is 
often the marketed (spec sheet) sensitivity of the microphone (for example, 
50 mV/Pa). You can assume that the nominal sensitivity is the same for all 
microphones on the system.

Sensitivity Offset—Enter the amount (in dB) that the normal sensitivity 
of the microphone differs from its nominal sensitivity. For example, 
a nominally 50 mV/Pa microphone with an normal sensitivity of 45 mV/Pa 
would have a sensitivity offset of 20 45 50⁄( ) 0.9dB–=log
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The sensitivity offset is determined by tracking the calibration sensitivities 
of your microphones over time, then inputting that data into Sound Power 
Plus.

Note The sensitivity offset of the microphone is used in conjunction with the quality 
assurance feature in Sound Power Plus that lets you establish an allowable deviation from 
the microphone’s normal sensitivity. Normal values for microphone sensitivity can be 
established by tracking average values over a period of time and entering the values in the 
microphone sensitivity file (Excel). Allowable deviations are established based on the 
laboratory’s allowance for calibration measurement uncertainty. The calibration routine 
displays a control chart that indicates the amount by which each microphone’s actual 
sensitivity differs from its normal sensitivity. Range limits on this control chart let you see 
when a microphone has calibrated outside of the control limits.

Frequency Response Corrections—Sound Power Plus lets you input 
frequency response corrections to be applied to the data measured for each 
microphone. This feature can correct for high-frequency response 
limitations of measurement microphones. You can enter corrections (in dB) 
from the microphone calibration frequency response data to be subtracted 
from the sound pressure level measured in each 1/3-octave band.

The convention used for frequency response corrections is that you enter 
the frequency response corrections as shown on a standard frequency 
response chart. For example, for a microphone with a frequency response 
that was 1.0 dB below the 0 dB reference level at 20 kHz, the value entered 
into the Excel microphone sensitivity file would be –1.0. Frequency 
response corrections are conducted as follows:

In the above example, the –1.0 dB frequency response correction would 
result in the SPL (recorded) being 1.0 dB greater than the SPL (measured).

Note Carefully check sign conventions for frequency response corrections to ensure they 
are being applied properly.

SPL (recorded) SPL (measured) Frequency Response Correction–=
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Instrument Configuration Files
Instrument configuration files contain all the configuration options for the 
instrument configuration menus. These files can be saved and loaded from 
the main menu bar. 

Sound Power Plus supports two types of instrument configuration files:

• Default—When Sound Power Plus starts, it loads an instrument 
configuration file that contains the default settings for the instrument. 
You can edit the default instrument configuration file so that the 
software loads the instrument configuration that is appropriate for your 
laboratory.

• Named Files—You can create several instrument configuration files 
and give each file a unique name.

Instrument configuration files are in .InC file format and can only be 
created or edited by using Sound Power Plus.

Measurement Configuration Files
Measurement configuration files contain all of the configuration options for 
the measurement configuration menus. There are separate measurement 
configuration files for both sound power and sound pressure level 
measurement. For each configuration, Sound Power Plus supports two 
types of measurement configuration files:

• Default—When Sound Power Plus starts, it loads sound power and 
sound pressure level measurement files that contain the default 
measurement configurations for the laboratory. You can edit the 
default measurement configuration file so that the software loads the 
most common measurement configuration that is appropriate for your 
laboratory each time the software starts.

• Named Files—You can create additional measurement configuration 
files and give each file a unique name. These files can be loaded and 
saved by using the Configuration option on the main menu bar.

Measurement configuration files are in .PWC and .SPC file formats for 
sound power level and sound pressure level measurement, and can only be 
created or edited by using Sound Power Plus.
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Reference Spectrum Files
Sound Power Plus lets you create default and named reference spectrum 
files. These reference spectra are displayed in the graphic window in 
association with the current graphic display. Reference spectra are 
displayed as a series of yellow dots on the RTA or test results display.

You can create reference spectrum files for the following spectra:

• Sound Power Level—A reference sound power level spectrum that is 
displayed when the graphic window is displaying sound power level 
test results.

• SPL for Sound Power Level—A reference sound pressure level 
spectrum that is displayed when the graphic window is displaying the 
SPL that is used for making sound power measurements.

• Operator/Bystander Sound Pressure Level—A reference sound 
pressure level spectrum that is displayed when the graphic window is 
displaying the SPL that is used for making operator/bystander sound 
pressure level measurements.

• Free Running Sound Pressure Level—A sound pressure level 
spectrum that is displayed when the RTA is in a free-running mode.

• FFT—An FFT reference spectrum that is displayed when the FFT 
analyzer is active.

Create reference spectra using controls on the graphic window or in a data 
table by selecting Reference»Edit Spectrum (with the exception of the 
FFT reference spectrum).

Report Template Files
The sample reports are provided with Sound Power Plus as a part of the 
Report Template.xls file, used to export data into Excel. This section 
describes the information typically found in the sample reports.
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Figure B-1.  Sample Sound Power Test Report

Measurement Information
All sound power data reported herein has been obtained in accordance with 
the procedures specified in Clause 6 of ISO 7779, except as noted. The unit 
under test was operated in accordance with the procedures specified in 
Annex C of ISO 7779, except as noted. All data is expressed in decibels 
(dB) with a reference level of 1 × 10-12 watts.

The following measurement setup was utilized to obtain this sound power 
data:

• Measurement Surface—Measurement Surface Data.

• Measurement Surface Dimensions (m)—Measurement Surface 
Dimension Data.

Laboratory Name: Your Laboratory
ISO 7779 Sound Power Test Report
Report Date: Today’s Date

Test Information

Test Name � Test Name Data
Test Date � Date/Time Data
Test Operator � Test Operator Data
Test Description � Test Description Data 
that can  be more than one line long.
Comments � Comment Data field that can 
be more than one line long.

Source Information

Source Type � Source Type Data
Manufacturer � Manufacturer Data
Model Number � Model Number Data
Serial Number � Serial Number Data
Operating Mode � Operating Mode Data
Mounting � Mounting Data
Dimensions (l × w × h mm) � xxxx × xxxx × xxxx 
Voltage (v) � Voltage Data 
Current (A)� Current Data
Line Freq (Hz) � LF Data    RPM � RPM Data

Meteorological Information

Temperature (C) � Temperature Data
Humidity (%) � Relative Humidity Data
Pressure (kPa) � Pressure Data

User Information

User Field Name 1 � User Field Data 1
User Field Name 2 � User Field Data 2
User Field Name 3 � User Field Data 3
User Field Name 4 � User Field Data 4
User Field Name 5 � User Field Data 5
User Field Name 6 � User Field Data 6
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C
Supported Drivers

Sound Power Plus supports plug-in driver architecture for multiplexers, 
which are commonly used in acoustic laboratories. If you are adding a new 
multiplexer to your system, you can write your own multiplexer driver in 
LabVIEW. The following drivers are installed with Sound Power Plus by 
default:

• Brüel & Kjaer 2811—8-channel GPIB microphone multiplexer 

• Brüel & Kjaer 2822—12-channel GPIB microphone multiplexer

• Larson-Davis 2210—10-channel, RS-232 microphone multiplexer

• Norsonic 834—10-channel, GPIB microphone multiplexer

Note The Brüel & Kjaer 2811 multiplexer driver performs well when used with newer 
Brüel & Kjaer 2811 devices. However, some problems have been noted in controlling 
Brüel & Kjaer 2811 devices featuring six-digit serial numbers. Additionally, older 
Brüel & Kjaer devices may use communication protocols that are not compatible with 
Sound Power Plus drivers.

For more information about any of these multiplexers, refer to the 
documentation that came with your multiplexer.
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Adding a New Multiplexer Driver
To add a new multiplexer driver to the system, open the 
Multiplexer.ini configuration file located in the 
Sound Power System\Data\Multiplexer Drivers folder. 
Add one section and fill in the corresponding key value according to 
your multiplexer information. The following is an example of the 
section structure:

[Multiplexer Name}

Index=4

Type=”Multiplexer Name”

Control Port =GPIB

Input Channel Number=10

Output Channel Number=1

Connected Output Channel=0,0,0,0,0,0,0,0,0,0

Description=Multiplexer Name\Multiplexer driver.vi

The index value is the multiplexer index in the configuration file. The 
description string is the name of the multiplexer driver VI in the Sound 
Power System\Data\Multiplexer folder.

You can view an example driver VI in the Multiplexer Driver.vi, which is 
located in the \Data\Multiplexer Drivers\Multiplexer Name\ 
directory. To ensure that the new driver will work properly with Sound 
Power Plus, verify that the connectors on your new driver VI matches the 
connectors on the example driver VI.

For more information about any of the supported multiplexers or to develop 
your own multiplexer driver, refer to the documentation from your 
multiplexer vendor.
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D
Technical Support Resources

Web Support
National Instruments Web support is your first stop for help in solving 
installation, configuration, and application problems and questions. Online 
problem-solving and diagnostic resources include frequently asked 
questions, knowledge bases, product-specific troubleshooting wizards, 
manuals, drivers, software updates, and more. Web support is available 
through the Technical Support section of ni.com. 

NI Developer Zone
The NI Developer Zone at ni.com/zone is the essential resource for 
building measurement and automation systems. At the NI Developer Zone, 
you can easily access the latest example programs, system configurators, 
tutorials, technical news, as well as a community of developers ready to 
share their own techniques.

Customer Education
National Instruments provides a number of alternatives to satisfy your 
training needs, from self-paced tutorials, videos, and interactive CDs to 
instructor-led hands-on courses at locations around the world. Visit the 
Customer Education section of ni.com for online course schedules, 
syllabi, training centers, and class registration.

System Integration
If you have time constraints, limited in-house technical resources, or other 
dilemmas, you may prefer to employ consulting or system integration 
services. You can rely on the expertise available through our worldwide 
network of Alliance Program members. To find out more about our 
Alliance system integration solutions, visit the System Integration section 
of ni.com.
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Worldwide Support
National Instruments has offices located around the world to help address 
your support needs. You can access our branch office Web sites from the 
Worldwide Offices section of ni.com. Branch office Web sites provide 
up-to-date contact information, support phone numbers, e-mail addresses, 
and current events. 

If you have searched the technical support resources on our Web site and 
still cannot find the answers you need, contact your local office or National 
Instruments corporate. Phone numbers for our worldwide offices are listed 
at the front of this manual.
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Glossary

Prefix Meaning Value

m- milli- 10–3

k- kilo- 103

Numbers/Symbols

% Percent.

A

A Amperes.

actual sensitivity The apparent sensitivity of the sensor during a particular calibration.

anechoic A test environment with acoustic wall treatments such that essentially no 
sound energy is reflected.

ANSI American National Standards Institute.

Awtd A-weighted. A standard frequency weighting applied to acoustic spectra to 
provide a single number level descriptor.

B

bel 1 bel = 10 dB

BNC Series 
(connector)

A radio frequency connector covered by military specification.

C

C Celsius.
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D

DAQ Data acquisition.

dB Decibel.

DSA Dynamic Signal Analyzer.

DSP Digital Signal Processing.

E

ECMA European Computer Manufacturers Association.

F

FFT Fast Fourier Transform.

full anechoic An anechoic chamber treated on all walls, ceiling, and floor surfaces.

G

GPIB General Purpose Interface Bus.

H

hemi-anechoic An anechoic chamber treated on the walls and ceiling, but with an 
acoustically reflective floor.

Hz Hertz.

I

I/O Input/output.

ICP Integrated Circuit Piezoelectric.
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Impulse A-weighting Applies a time constant to a measurement to detect energy in impulsive 
sounds.

ISO International Standards Organization.

K

K2 A correction, in decibels, applied to surface averaged sound pressure level 
data to correct for the influence of the acoustic test environment on the 
measurement result. Defined and used as in ISO 3744.

M

m Meters.

measurement session A series of measurements on a device under test that may include sound 
power and sound pressure level measurements.

mux Multiplexer.

N

nominal sensitivity The marketed sensitivity of a sensor.

normal sensitivity The “everyday use” sensitivity of a sensor. You determine the normal 
sensitivity by tracking the sensor’s sensitivity over time.

O

OLE Object Linking and Embedding. A Microsoft standard protocol for 
allowing applications that use OLE technology to share and link to data in 
other applications.

P

Pa Pascal.

parallelepiped A rectangular “box” measurement surface, which is defined in ISO 7779.
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PR Prominence ratio.

PWL Sound power level.

R

RPM Revolutions per minute.

RS-232 An industry standard interface for connecting serial devices.

RTA Real time analyzer.

S

sensitivity offset The amount by which the sensor normally deviates from its nominal value.

SPL Sound pressure level.

T

TNR Tone-to-noise ratio.

V

V Volt.

VI Virtual instrument.

W

.wav An industry standard format for sound files.
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Index

A
alphanumeric indicators

FFT display, 1-10
RTA display, 1-8
test results display, 1-12

ambient correction calculation logic
position-by-position corrections (table), A-4
surface average corrections (table), A-6

ambient correction configuration
Sound Power Level Calculation data 

window, 5-13
Sound Pressure Level Calculation data 

window, 6-8
Ambient Correction Configuration data window

operator/bystander sound pressure level 
measurement, 2-38

sound power level measurement
ambient correction limitations, 2-24
configuration options, 2-23

Ambient SPL Measurement data window
sound power level measurement, 5-2
sound pressure level measurement, 6-2

Auto Ranging Configuration data window, 2-42

B
BNC 2140 breakout box installation, 2-2
bystander sound pressure level measurement. 

See operator/bystander sound pressure level 
measurement

C
calibration

data file displayed in data window, 1-6

microphone calibration
Calibration Configuration data 

window, 4-5
calibration routine logic, 4-1
configuring calibration, 4-2
saving calibration data, 4-7

sound power level measurement, 5-1
sound pressure level measurement, 6-1

Calibration menu, 1-14
configuration

Auto Ranging Configuration data 
window, 2-42

entering new configuration data, 2-4
instruments

configuration concepts, A-1
data acquisition (DAQ) board, 2-6
entering or changing, 2-5
microphone, 2-11
multiplexer, 2-8
overview, 2-5

loading configuration file, 2-3
measurement configuration concepts

example microphone system 
(figure), A-3

microphone assignment logic 
(table), A-2

operator/bystander calculations
bystander average sound pressure 

level, A-12
operator average sound pressure 

level, A-12
operator/bystander sound pressure level 

measurement
Ambient Correction Configuration data 

window, 2-38
entering or changing settings, 2-32
loading configuration file, 2-32
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Measurement Configuration data 
window, 2-33

Position Configuration data 
window, 2-35

Sound Quality Analysis data 
window, 2-40

password protection, 2-4
prominent tone logic and calculations 

(table), A-10
reference spectrum configuration, 8-2
saving configuration data, 2-4
sound power ambient correction 

calculation logic
position-by-position corrections 

(table), A-4
surface average corrections 

(table), A-6
sound power level measurement

Ambient Correction Configuration 
data window, 2-23

ambient correction limitation, 2-24
entering or changing settings, 2-16
Environmental Correction data 

window, 2-25
FFT Measurement Configuration 

data window, 2-29
loading configuration file, 2-15
Measurement Configuration data 

window, 2-17
Measurement Option Configuration 

data window, 2-27
Position Configuration data 

window, 2-19
sound pressure level measurement 

precision and rounding issues, A-12
sound quality analysis calculations, A-8

Configuration menu, 1-14
contacting National Instruments, D-2
controls

FFT, 1-11
RTA, 1-8
test result controls, 1-13

conventions used in this manual, ix
cursors

FFT cursors, 1-11, 5-12, 6-13
RTA, 1-8
test result, 1-13

customer
education, D-1
technical support, D-1

D
data acquisition (DAQ) board 

configuration, 2-6
data files. See program and data files
data window, 1-5
Developer Zone, D-1
diagnostic resources, D-1
documenting tests

meteorological information, 3-6
saving documentation, 3-9
source information, 3-4
user information, 3-8

driver support
adding new multiplexer driver, C-2
default installed drivers, C-1
overview, 1-2

E
Environmental Correction Data window, 2-25
Excel worksheets

microphone sensitivity parameter 
files, B-5

saving data in Excel files, 7-1
workbook export templates, B-3

exporting data
data export files, B-3
Data Export window, 7-1
Excel files, 7-1
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sound source pressure level 
measurement data, 5-8

text files, 7-3
workbook templates, B-3

F
FFT cursors

FFT display, 1-11
Prominent Tone Listening Test data 

window, 6-13
source SPL measurement, 5-12

FFT display
alphanumeric indicators, 1-10
FFT controls, 1-11
FFT cursors, 1-11
figure, 1-10
Prominent Tone Listening Test data 

window, 6-13
FFT Measurement Configuration data 

window, 2-29
FFT measurement in Source SPL 

Measurement data window, 5-9
FFT window prominent tone analysis 

controls, 6-14
File menu, 1-13
files. See program and data files
flowchart buttons (table), 1-5
flowchart window, 1-5
frequently asked questions, D-1

G
GPIB board installation, 2-2
graphic window

FFT display, 1-10
overview, 1-6
RTA display, 1-7
test results display, 1-12

H
hardware installation. See installation
help

technical support, D-1
Help menu, 1-14

I
importing microphone parameter files, B-5
indicators, alphanumeric. See alphanumeric 

indicators
installation

See also configuration
BNC 2140 breakout box installation, 2-2
configure WIndows settings, 2-1
GPIB board installation, 2-2
Sound Power System software, 2-3

instrument configuration
configuration concepts, A-1
configuration files, B-7
data acquisition (DAQ) board, 2-6
entering or changing, 2-5
instrument configuration file, 1-6
microphone, 2-11
multiplexer, 2-8
overview, 2-5

M
main menu bar, 1-13
Measurement Configuration data window

operator/bystander sound pressure level 
measurement, 2-33

sound power level measurement, 2-17
measurement configuration files, B-7
measurement data file, 1-6
measurement devices, 1-2
measurement option configuration

Measurement Option Configuration data 
window, 2-27
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Sound Power Calculation data 
window, 5-13

Sound Power Level Calculation data 
window, 5-13

meteorological documentation
Sound Power Calculation data 

window, 5-14
Sound Power Level Calculation data 

window, 5-14
test documentation, 3-6

Meteorological Documentation data 
window, 3-6

microphone calibration
Calibration Configuration data window

calibration configuration 
parameters, 4-6

calibration control chart, 4-6
figure, 4-5
microphone selection, 4-6

calibration routine logic, 4-1
configuring calibration

auto-calibration options, 4-4
calibration parameters, 4-3

overview, 4-1
saving calibration data, 4-7

microphone configuration
configuration options, 2-12
example microphone system (figure), A-3
importing microphone parameter 

files, B-5
microphone assignment logic (table), A-2
Microphone Configuration window, 2-11

multiplexer configuration
assignment to input channel, 2-10
figure, 2-8
setup options, 2-9

multiplexer driver, adding, C-2

N
National Instruments

Alliance Program, D-1
customer education, D-1
Developer Zone, D-1
system integration services, D-1
technical support, D-1
Web support, D-1
worldwide offices, D-2

NI Developer Zone, D-1

O
online technical support, D-1
operator/bystander sound pressure level 

measurement
calculations

bystander average sound pressure 
level, A-12

operator average sound pressure 
level, A-12

configuration
Ambient Correction Configuration 

data window, 2-38
entering or changing settings, 2-32
loading configuration file, 2-32
Measurement Configuration data 

window, 2-33
Position Configuration data 

window, 2-35
Sound Quality Analysis data 

window, 2-40
Source Sound Pressure Measurement 

data window, 6-5
Option menu, 1-14
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P
password protection, 2-4
Position Configuration data window

operator/bystander sound pressure level 
measurement, 2-35

sound power level measurement, 2-19
position configuration, Sound Pressure Level 

Calculation data window, 6-9
program and data files

data export files, B-3
data file overview, 1-3
file types used by Sound Power System 

(table), B-1
instrument configuration files, B-7
measurement configuration files, B-7
reference spectrum files, B-8
report template files, B-8

Prominent Tone Listening Test data window
FFT display and cursors, 6-13
FFT window prominent tone analysis 

controls, 6-14
prominent tone analysis results, 6-16
prominent tone table, 6-17
Tone Analysis data window, 6-12

prominent tone logic and calculations
analysis logic (figure), A-9
calculations (table), A-10

PWL configuration file, 1-6

R
real time analyzer. See RTA display
Reference menu, 1-14
reference spectrum configuration

configuration files, B-8
configuration procedure, 8-2
entering reference spectra, 8-1
types of spectra, 8-1

Reference Spectrum Edit for Instrument 
Configuration data window, 8-3

related documentation, ix

reports
See also test results display
report template files, B-8
Sound Power Level Report data 

window, 5-15
Sound Pressure Level Report data 

window, 6-18
RTA display

alphanumeric indicators, 1-8
figure, 1-7
RTA controls, 1-8
RTA cursor, 1-8

S
saving

configuration data, 2-4
microphone calibration data, 4-7
sound power level measurement 

data, 5-17
test documentation, 3-9

sound power ambient correction calculation 
logic

position-by-position corrections 
(table), A-4

surface average corrections (table), A-6
sound power level measurement

Ambient SPL Measurement data 
window, 5-2

calibration, 5-1
configuration

Ambient Correction Configuration 
data window, 2-23

ambient correction limitation, 2-24
entering or changing settings, 2-16
Environmental Correction data 

window, 2-25
FFT Measurement Configuration 

data window, 2-29
loading configuration file, 2-15
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Measurement Configuration data 
window, 2-17

Measurement Option Configuration 
data window, 2-27

Position Configuration data 
window, 2-19

PWL configuration file, 1-6
reviewing results, 5-15
saving measurement data, 5-17
Sound Power Level Calculation data 

window, 5-13
ambient correction 

configuration, 5-14
measurement option 

configuration, 5-14
meteorological documentation, 5-14

Source SPL Measurement data 
window, 5-5

FFT cursors, 5-12
FFT measurement, 5-9

Sound Power Level Report data window, 5-15
Sound Power System

See also configuration
Calibration menu, 1-14
Configuration menu, 1-14
data window, 1-5
File menu, 1-13
flowchart window, 1-5
graphic window

FFT display, 1-10
RTA display, 1-7
test results display, 1-12

Help menu, 1-14
installation, 2-1
main menu bar, 1-13
Option menu, 1-14
overview, 1-1
program overview, 1-2
Reference menu, 1-14
supported drivers, 1-2, C-1

system requirements, 1-1
user interface (figure), 1-4

sound pressure level measurement
Ambient SPL Measurement data 

window, 6-2
calibration, 6-1
configuration file displayed in data 

window, 1-6
precision and rounding issues, A-12
reviewing results, 6-18
Sound Pressure Level Calculation data 

window, 6-8
ambient correction configuration, 6-9
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controls, 6-14
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measurement, 6-5
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exporting data, 5-8
FFT cursors, 5-12
FFT measurement, 5-9
options, 5-5
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supported drivers. See driver support
system integration, by National 
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system requirements, 1-1

T
technical support resources, D-1
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saving documentation, 3-9
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Test Documentation data window, 3-2
test results display

alphanumeric indicators, 1-12
figure, 1-12
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test results cursor, 1-13

test routines, 1-2
text file, exporting data to, 7-3
training, customer, D-1
troubleshooting resources, D-1

U
User Documentation data window, 3-8
user interface (figure), 1-4

W
Web support from National Instruments, D-1
Windows settings requirements, 2-1
workbook templates, B-3
worldwide technical support, D-2
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